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Thank you for purchasing the MX100 Data Acquisition Unit.
This user’s manual contains useful information about the functions and operating 
procedures of the MX100 Standard Software and lists the handling precautions of the 
software. To ensure correct use, please read this manual thoroughly before beginning 
operation.
After reading the manual, keep it in a convenient location for quick reference whenever a 
question arises during operation.
The following five manuals relating to the MX100 Data Acquisition Unit (hereinafter the 
“MX100”) are provided in addition to this one. Read them along with this manual.
The MX100 Data Acquisition Unit User’s Manual (IM MX100-01E), MX100 Data 
Acquisition Unit Operation Guide (IM MX100-02E), and this manual (IM MX180-01E) are 
all available on the MX100 Manual CD-ROM.
Manual Title Manual No. Description
MX100 Data Acquisition Unit User’s 
Manual

IM MX100-01E Describes the functions, installation, 
wiring procedures, handling 
precautions, and other information 
about MX100.

MX100 Data Acquisition Unit 
Operation Guide

IM MX100-02E Describes concisely the handling of the 
MX100 and the basic operations of the 
MX100 Standard Software.

Precautions on the Use of the 
MX100/MW100 Data Acquisition 
Unit

IM MX100-71E Summarizes the usage precautions of 
the MX100/MW100.

MX100/MW100 Data Acquisition Unit 
Installation and Connection Guide

IM MX100-72E Describes concisely the installation 
and wiring procedures of the MX100/
MW100.

Control of pollution caused by 
MX100/MW100 products

IM MX100-91C Describes control of pollution caused by 
the product.

Notes
•	 This manual describes the MX100 Standard Software, release number “R3.03.01.” 

You can check the release number by choosing About from the Help menu of 
the Standard Software.

•	 The contents of this manual are subject to change without prior notice as a result of 
continuing improvements to the software’s performance and functions. The figures 
given in this manual may differ from those that actually appear on your screen.

•	 Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

•	 This user’s manual does not cover the handling and operating procedures of 
Windows.

•	 Copying or reproducing all or any part of the contents of this manual without 
YOKOGAWA’s permission is strictly prohibited.

Trademarks
•	 DAQMASTER is a registered trademark of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).
4th Edition: March 2012 (YK)
All Rights Reserved, Copyright © 2003 Yokogawa Electric Corporation
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Revisions
•	 1st Edition:	 May, 2003	 •	 4th Edition:	 March 2012
•	 2nd Edition:	 November, 2004
•	 3rd Edition:	 February, 2008
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric 
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa 
Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing  the Yokogawa Software Program, you acknowledge that you 
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the 
documentation and separately attached.  Accordingly, the Terms and Conditions bind you. 

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or 
those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.  

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions 
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT TO 
YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program 
(hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions stipulated in 
Article 1 hereof. 
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the 
“Agreement”) based on the use intended for the Licensed Software.  
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event 
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.
Licensed Software Name:	 MX100 Standard Software (Model MX180)
Number of License:	1

Article 1 (Scope Covered by these Terms and Conditions)
1.1	 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the 

Licensee consents to agree to the terms and conditions stipulated herein.
1.2	 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology, 

algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1	 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the 

license fee separately agreed upon by both parties.  
2.2	 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the 

Licensed Software.
2.3	 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall secure 

or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care. 
2.4	 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may 

translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed Software.  
Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed Software. 

2.5	 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants 
Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed Software.

2.6	 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove such 
copy protection.

2.7	 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may 
include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted permission 
to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions than those 
stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in writing separately.

2.8	 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, 
including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1	 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for 

the purpose of the following events:
a)	Operation of any aviation, vessel, or support of those operations from the ground;,
b)	Operation of nuclear products and/or facilities;,
c)	Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d)	Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility 
for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, 
to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, 
damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims arising out of and 
related to the above-said claims and damages.

Article 4 (Warranty)
4.1	 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such as 

damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed 
Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility within seven 
(7) days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as is” basis when 
delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation, data on computer 
programs and program listings, be completely accurate, correct, reliable, or the most updated. 

4.2	 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms 
and conditions that apply shall be those established by the provider of the third party software. 
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4.3	 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision 
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4	 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted 
renovation or improvement of the Licensed Software.

4.5	 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, 
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD 
PARTY SOFTWARE TO YOKOGAWA.

4.6	 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any 
failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the 
Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in warranty, 
contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or arising out of 
the use of the Licensed Software.

Article 5 (Infringement)
5.1	 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under 

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed 
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2	 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate 
with the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s 
defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the 
preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s cost and expense and be 
responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3	 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s 
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at 
Yokogawa’s cost and expense.

a)	To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use 
the Licensed Software;

b)	To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa 
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee.  
THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY 
SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT 
LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided 

to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this 
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage, 
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue, loss 
of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s business, 
substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of Licensee or 
other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee 
which Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement 
if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic specifications or functional 
specifications, without Yokogawa’s prior written consent.

6.2	 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless 
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3	 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between 
the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other 
than those where Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until 
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice 
to the Licensee.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems 
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other 
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to 
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably 
through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after notice from one 
of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for 
settlement of the dispute.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely 
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the 
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null 
and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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1.1	 Functional Explanation of the MX100 Standard 
Software

Functional Overview
The software can be used when the PC and the MX100 are connected in a one-to-one 
configuration. To connect multiple MX100s to a PC, you need to use MXLOGGER, a 
software program sold separately.

		

MX100

MX100 Standard
Software

Hub

MX100

Input/Output module Main module

Ethernet port

PC

The MX100 Standard Software consists of the three software programs described below.
•	 Integration Monitor
	 Enables you to connect or disconnect the MX100, configure acquisition conditions and 

display conditions of the measured data, set up computations, monitor measured and 
computed data, save measured and computed data, and carry out other operations.

			 

Chapter 1	 Before Using the Software
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•	 Viewer
	 Enables you to display measured and computed data that has been saved, read 

values and perform statistical computation over an area using cursors, and convert 
the measured and computed data into various file formats such as Excel.

			 

•	 Calibrator
	 Enables you to calibrate the MX100 input/output modules.

			 

Integration Monitor
The main operations are carried out using the six windows shown below. If the MX100 is 
not connected, the windows other than the Connection window cannot be displayed.

•	 Connection screen
	 You can search for MX100s in the same segment, and connect to the target MX100. 

You can also assign a machine name, IP address, subnet mask, and default gateway 
to the detected MX100. Once a connection is established, the connection is made 
automatically to the same MX100 the next time the Integration Monitor is started.

•	 System setup screen
	 You can change the A/D integration time and check the main module information.
	 When the attached input/output module is changed, you can update the module 

configuration information.
	 You can check the network setup information of the connected MX100.
	 You can format the CF card or check the free space on the CF card of the connected 

MX100.

•	 Acquisition setup screen
	 You can set the monitor interval of the measured data and the record start/stop 

conditions. You can also set the save destination, file name, file division, and comment 
of the recorded data.

1.1  Functional Explanation of the MX100 Standard  Software
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•	 Channel setup screen
	 For each measurement channel you can set: the input type, measurement range, 

measurement span, and other measurement conditions; whether or not to assign 
the channel for measurement/recording; the alarm output conditions, and the initial 
balancing of the strain input modules. You can also set computations such as the four 
arithmetical operations using the measured data (computation channel setting), set 
the signal to be output from the digital output module (DO channel setting), set the 
signal to be output from the analog output module (AO channel settings), and set the 
signal to be output from the PWM output module (PWM channel settings).

•	 Display setup screen
	 For each display group, you can set the channel to be displayed, display scale, display 

zone, trip point (the value of interest in the waveform display), display color, and other 
parameters.

•	 Monitor screen
	 You can display the waveforms and numeric values of the measured/computed data, 

change the display method, start/stop the recording of the measured/computed data, 
pause the monitor, manually control the digital output, analog output, and PWM 
output, and perform other operations. When the monitor is paused, you can display 
the past data and read computed/measured values using cursors.

In addition to the operations described above, you can also save the setup data (project), 
print a list of settings, and perform other operations from the menu.

Viewer
You can load the measured/computed data that was saved in the past and carry out the 
following operations.
•	 Synchronization
	 When the data file is opened, the measurement time is corrected based on the time 

information of the PC.
•	 Waveform display/numeric display
•	 Alarm/mark list display
•	 Change the display conditions (group assignments, scale, trip point, display color and 

other parameters)
•	 Read values using cursors
•	 Perform statistical computation over an area
•	 Display and add marks
•	 Print the waveform display and numeric value display
•	 Save or load display conditions
•	 Display the file information
•	 Convert data formats (ASCII, Excel, and Lotus)
•	 Printing data (waveforms, numeric values, alarm/mark list, cursor values, statistics 

over an area, and computed values)
•	 Use and save templates

Calibrator
You can connect to the MX100, display the modules that can be calibrated, and carry out 
calibration of each measurement range and output range.

1.1  Functional Explanation of the MX100 Standard  Software
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1.2	 System Requirements

OS (Operating System)
Run the software under any of the following operating systems.
•	 Windows 2000 Professional SP4
•	 Windows XP Home Edition SP3
•	 Windows XP Professional SP3 (excluding Windows XP Professional x64 Edition)
•	 Windows Vista Home Premium SP1, SP2 (excluding the 64-bit edition)
•	 Windows Vista Business SP1, SP2 (excluding the 64-bit edition)
•	 Windows 7 Home Premium (32-bit and 64-bit editions)
•	 Windows 7 Professional (32-bit and 64-bit editions)

The language displayed by the software under different language versions of the OS are 
as follows.

OS Language Software Display Language
English or other English
Japanese Japanese or English

PC
A PC that runs one of the OS above, and that meets the following CPU and memory 
requirements. 
•	 When Using Windows 2000 or Windows XP
	 Pentium 4, 1.6 GHz or faster Intel x64 or x86 processor; 512 MB or more of memory
•	 When Using Windows Vista
	 Pentium 4, 3 GHz or faster Intel x64 or x86 processor; 2 GB or more of memory
•	 When Using Windows 7
	 32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 processor; 2 GB or more of 

memory 
	 64-bit edition: Intel x64 processor that is equivalent to Intel Pentium 4, 3 GHz or faster; 

2 GB or more of memory

Free Hard Disk Space and RPM
Free space:  50 MB or more (1 GB or more recommended)
RPM:  7200 rpm or faster recommended

Input Devices (Mouse, Keyboard, Etc.)
Input devices supported by the OS.

Display
A video card that is recommended for the OS and a display that is supported by the OS, 
has a resolution of 1024×768 or higher, and that can show 65,536 colors (16-bit, high 
color) or more.

Ethernet Port
An Ethernet port compatible with the OS (10BASE-T or 100BASE-TX) required.
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1.3	 Setup Procedures of the MX100 Standard 
Software

The following procedures are for installing the software on Windows XP.

1.	 Start Windows.
Log onto Windows as an administrator (Otherwise, you will not be able to install the 
software). This is the same when using an OS other than Windows XP.

When Auto Run Is Enabled
2.	 Insert the CD-ROM in the CD-ROM drive.
	 The setup program automatically starts. Proceed to step 4.

When Auto Run Is Disabled
2.	 Double-click the CD-ROM icon from My Computer to open the CD-ROM drive 

window.

3.	 Double-click the SETUP.EXE file.
The setup program starts.

4.	 Select the languages and click Next. 

5.	 Click Next. Read the Software License Agreement that appears. If you agree to 
the terms, select the I accept terms of the license agreement check box. Click 
Next.

6.	 In the next dialog box, enter the user name, company name, and license number, 
and click Next.
The license number is written on the label that is attached to the front of the case for the 
MX100 Standard Software Setup CD-ROM.

					   



1-6 IM MX180-01E

7.	 Select the setup type to install, and click Next.
The default destination to install is [C:\MX100 Standard]. If you click Custom check box, 
you can select the installation location and installed functions. Note that if you select MX100 
Standard in the installation function, MX100 Viewer will also be installed. Follow the on-
screen instructions.

					   

8.	 Click Install to start the installation.

9.	 Click Finish to finish the installation.

1.3  Setup Procedures of the MX100 Standard Software
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Explanation
Installation Result
When the software program is installed properly, the folder MX100 Standard Software 
is created in the specified directory (C:\ by default). MX100 Standard is registered in the 
program list and MX100 Standard (referred to as the Integration Monitor in this operation 
guide), MX100 Viewer, and MX100 Calibrator are registered under it.

		

Note
•	 The Data, Work, and Conv folders are created within the MX100 Standard folder. Recording 

files are saved in the Data folder. The Work folder is used as a temporary folder for saving 
files created by the MX100 Standard Software, and must not be deleted.

•	 The Conv folder is created by the Historical Viewer. It is used as a temporary folder for 
storing files used for file conversion, and must not be deleted.

1.3  Setup Procedures of the MX100 Standard Software
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1.4	 Starting and Exiting Software Programs

Procedure
Starting the Software Programs
As shown in the figure below, click the Start button, point to Programs, point to MX100 
Standard, and choose MX100 Standard (referred to as the Integration Monitor in this 
manual), MX100 Viewer, or MX100 Calibration.

		

Exiting the Software
From the File menu, choose Exit.
The following figure shows an example of the Integration Monitor (MX100 Standard)

		

Note
When exiting the MX100 Viewer, a dialog box confirming whether to save the display settings 
opens if the display settings have been changed.
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2.1	 Connecting and Disconnecting the MX100

Procedure
Before carrying out the procedure below, turn ON the power to the relevant MX100 and 
connect the MX100. When connecting the MX100 for the first time, the MX100 and the 
PC must be connected locally in a one-to-one configuration.

Note
Connecting the MX100 and the PC to a mission-critical network before an appropriate IP address 
is assigned to the MX100 may adversely affect other connected devices on the network.

Connecting to an MX100 That Has Not Been Configured for the Network
1.	 Start the Integration Monitor according to the procedure given in section 1.4.

The Connection screen opens.

					   

2.	 Click the Search button.
If an MX100 is found, icons appear in the frame containing the Search button for MX100s in 
the same network segment.

					   

Instrument number (NO.) written on the
name plate of the main module

Displays the icon of the MX100 in the same network segment

MX100 machine name

Name of PC connected to the MX100
Icon indicating connection by other software

Note
•	 If multiple MX100s are connected in the same network segment, multiple icons appear 

together with the corresponding instrument numbers (NO.).
•	 When using Windows XP, Windows Vista, or Windows 7 with the firewall enabled, 

recognition is sometimes not successful even when clicking the Search button. To solve the 
problem, see appendix 1. (The same problem may also occur if your anti-virus software is 
using a firewall.)

Chapter 2	 Integration Monitor
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3. 	 Click the MX100 icon that appeared.
In the box containing the Edit Network setup button, the icon and the initial network 
information of the selected MX100 appear.
Even if you click the Connect button in this condition (with the initial IP address), connection 
cannot be made.

					   

Click the MX100 icon

Clicking here causes the 
7-segment LED of the 
corresponding MX100 to 
display --CALL--

Default network information

4.	 Click the Edit Network setup button.
The Machine Name, IP address, Subnet Mask, and Default Gateway items turn into text 
boxes.

5.	 Refer to the explanations in this section and enter the required information in the 
boxes.
The Apply and Cancel buttons appear.

6.	 Click Apply.
In the box containing the Edit Network setup button, the icon and the network information of 
the MX100 disappear. At this moment, the 7-segment LED that has been configured turns 
off for an instant.

Click the Edit Network setup button to
change the display to input boxes

Click
here

Enter the necessary information using
characters.  Enter up to 64 characters
for the machine name

When you click the Apply button
the icon and network information
disappear.

• Invalid IP address setting • Invalid Subnet mask
  setting

• Invalid default
  gateway setting

If the network setup does not work, the following screen appears.

Check whether the IP address
setting is appropriate and whether
the combination of the IP address
and subnet mask is appropriate.

Check whether the
subnet mask setting
is appropriate.

Check whether the
default gateway
setting is appropriate.

• Failed to change
  settings

Check if the MX100 is
connected by another
program or if the power
to the MX100 is OFF.

• Failed to change
  settings

Repeat steps 2 through 6

2.1  Connecting and Disconnecting the MX100
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7.	 Click the MX100 icon in the box containing the Search button.
In the box containing the Edit Network setup button, the icon and the network information of 
the configured MX100 appear.

					   

Click here Displayed with the
changes applied

8.	 Click the Connect button in the box containing the Edit Network setup button.
If the MX100 is connected, the Monitor screen appears and measurement begins.

					   

Click here

		  Monitor screen

					   

2.1  Connecting and Disconnecting the MX100
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Connecting to an MX100 That Has Been Configured for the Network
1.	 Start the Integration Monitor.

If the MX100 that was connected when the program was started the previous time is still 
connected, a connection is automatically established with that MX100, the Monitor screen 
opens, and measurement starts. To connect to another MX100, click Connection located at 
the top section of the Monitor screen to show the Connection screen and click Disconnect.

2.	 In the IP Address or Host Name box on the Connection screen, enter the IP 
address of the MX100 to which you wish to connect.
To connect using a host name, the host name must be registered in a DNS server (see the 
explanation in this section) and the DNS server must be connected to the network.

3.	 Click the Connect button to the right of the IP Address or Host Name text box.
The Monitor screen opens.

					   

Enter the IP address of the desired MX100
and click the Connect button.

Note
•	 If the connection cannot be made for some reason such as when the MX100 is already 

connected by another software program, the dialog box indicating that it is connecting 
remains on the screen. If the MX100 that you are trying to connect to is in the same 
segment, click Abort in the dialog box and then click Search to see if the MX100 is actually 
connected to the network or if it is connected by another software program.

					   

•	 If you changed the module configurations on the MX100 that you had connected before, a 
dialog box with the message “Some detected modules do not match the current software 
configuration. Rebuild based on the current MX hardware setup?” appears. If this happens, 
carry out the procedure in the next section, 2.2, “Configuring the System, Setting the Write 
Mode of the CF Card, and Formatting the CF Card.”

					   

•	 If there is a record file that has not been finalized (data writing has not been completed) in 
the previous connection, the finalization of the record file is carried out immediately after 
startup. If this occurs, the progress of the finalization is displayed on the status bar (see 
“Setting the Status Bar Display on the View Menu” in section 2.6).

2.1  Connecting and Disconnecting the MX100
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Changing the Network Configuration
1.	 With the MX100 icon and network information displayed in the box containing the 

Edit Network setup button on the Connection screen, click the Edit Network setup 
button.
The Machine Name, IP address, Subnet Mask, and Default Gateway items turn into text 
boxes.

2.	 Refer to the explanations in this section and enter the required information in the 
boxes.
The Apply and Cancel buttons appear.

3.	 Click Apply.
Click Cancel to return to the original settings.

Network setup cannot be changed 
when there is another connected 
software program

A yellow mark is displayed if there is
a connected user/software.Click here

• Invalid IP address setting • Invalid Subnet mask setting • Invalid default gateway setting

• When the MX100 you wish to
   configure is connected by
   another software program
•  When you attempt to change
    the IP address while the
    connection is established

When network setup does not work,
the following screen appears.

Check whether the IP address
setting is appropriate and whether
the combination of the IP address
and subnet mask is appropriate.

Check whether the subnet mask
setting is appropriate.

Check whether the default gateway
setting is appropriate.

• When the message “Search
   MX100s nearby again” appears.

Note
Enter network settings to avoid conflicts with other PCs. If network settings or searches are 
performed on multiple PCs simultaneously, the operation may fail.

2.1  Connecting and Disconnecting the MX100
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Disconnecting the MX100
1.	 Click Connection to show the Connection screen.

2.	 Click the Disconnect button to the right of the IP Address or Host Name text box.

					   

	 When the connection is dropped, a message “Currently no MXs are connected” 
appears at the top section of the screen. To reconnect, click Connect.

					   

Creating a New Project and Connecting
Creating a New Project
Carry out the procedure below to discard current settings and create new setup data 
(project).

1.	 From the File menu, click New.
A dialog box with the message “Cancel the current settings and create a new project?” 
appears. To save the current setup data before creating a new project, click No and save 
the setup data (project) (see “Saving Setup Data (Project)” in section 2.12).

2.	 Click Yes.
The Connection screen opens. If you click New while the MX100 is connected, 
communication with the connected MX100 is disconnected.

					   

Connecting after Creating a New Project
3.	 On the Connection screen, connect to the MX100.

(See “Connecting to an MX100 That Has Not Been Configured for the Network,” or 
“Connecting to an MX100 That Has Been Configured for the Network,” in this section.)

2.1  Connecting and Disconnecting the MX100
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Explanation
Machine Name
To distinguish individual MX100s, you can enter a name that is easy to identify using up 
to sixty-four characters (not required).

IP Address
Enter a new IP address to assign to the MX100. The default address is 127.1.1.XX (where 
XX is a unique number for the device). This address cannot be used even when the 
PC and the MX100 are connected in a one-to-one configuration. You must change to a 
different address such as 192.168.1.XX (where XX is a value between 1 and 254). When 
connecting the PC locally, do not set the PC to obtain the IP address automatically. Enter 
the IP address manually to an address other than the one that is to be assigned to the 
MX100 (192.168.1.100 if 192.168.1.1 was assigned to the MX100, for example).

Note
•	 To connect to the MX100 by entering a host name in the IP Address or Host Name box, the 

host name (name used on the TCP/IP network) must be registered in a DNS server and the 
DNS server must be connected to the network. However, the MX100 Standard Software 
does not have a function for registering host names on the DNS server. For the procedure of 
registering host names, consult your network administrator.

•	 To initialize all settings including the IP address to the their factory default values, see 
“Initializing the Settings” in section 2.6 of the MX100 Data Acquisition Unit User’s Manual (IM 
MX100-01E).

Subnet Mask
Enter the mask value used when determining the subnet network address from the IP 
address. The default value is 255.255.255.0. When connecting to the PC locally in a one-
to-one configuration, this value does not need to be changed. In this case, set the subnet 
mask on the PC to 255.255.255.0 as well.

Note
Huge TCP/IP networks such as the Internet are often divided up into smaller networks called 
sub networks. The subnet mask is a 32 bit value that specifies the number of bits of the IP 
address used to identify the network address. The portion other than the network address is 
the host address that identifies individual computers on the network. Consult your network 
administrator for the subnet mask value. You may not need to set the value.

Default Gateway
Set the IP address of the gateway (default gateway) used to communicate with other 
networks. The default value is 0.0.0.0. When connecting to the PC locally in a one-to-one 
configuration, this value does not need to be changed. In this case, you do not have to 
set the default gateway on the PC.

Note
The default gateway is a router or computer that is used when accessing a computer outside its 
own network. Consult your network administrator for the IP address of the default gateway.

2.1  Connecting and Disconnecting the MX100
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Model
Displays MX100.

Option
Displays /DS or None.

Version
Firmware version number of the main module.
The version number shows the style number (before the decimal point) and revision 
number (after the decimal point).

Serial ID
The instrument number (NO.) marked on the name plate of the main module.

MAC Address
Displays the MAC address that is assigned when the MX100 is shipped from the factory 
(unique ID number for identifying the Ethernet card). The MAC address is marked on the 
name plate on the main module.

Connected Users
Displays the computer name of the PC that is connected to the MX100. This item is blank 
if there is no PC connected to it.

Software
Displays the name of the software program that is connected to the MX100. This item is 
blank if there is no software program connected to it.
•	 MX100 Standard:	 Integration Monitor of the MX100 Standard Software
•	 MX100 Calibrator:	 Calibrator of the MX100 Standard Software or 
		  MXLOGGER (sold separately)
•	 MXLOGGER:	 MXLOGGER (sold separately)
•	 API:	 Software applications can be created using the MX100/ 
		  DARWIN API (sold separately)

2.1  Connecting and Disconnecting the MX100
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2.2	 Configuring the System, Setting the Write Mode 
of the CF Card, and Formatting the CF Card

Procedure
Reconfiguring the System

If you change the attachment positions or type of the input/output modules you must 
carry out the procedure below.

Note
•	 If you change the MX100 input/output modules, a message, “Some detected modules do 

not match the current software configuration. Rebuild based on the current MX hardware 
setup?” appears when you start the Integration Monitor. Current configuration refers to the 
module configuration (attachment positions and types of modules) that is detected by the 
software. To match the current configuration with the actual module configuration (referred 
to as reconfiguring the system), click Yes. If you reconfigure, the settings (measurement 
conditions, etc.) of the modified modules are initialized. The reconfigured module 
configuration can be confirmed on the System screen that appears by clicking System. If 
you Click No, the connection is made without reconfiguration, and the module settings are 
left unchanged.

•	 Turn OFF the power to the MX100 when attaching or detaching input/output modules.

1.	 Click System to show the System setup screen.

					   

Click here

2.	 Click the Actual Configuration tab followed by the Retrieve current configuration 
button.
An X mark is displayed on the changed modules.

Click here

Click here Changed modules

Note
•	 The × mark appears at slots where the module has been changed, and which are not 

operating correctly.
•	 The serial number is not displayed to the right of the module type (MX115-D05-H10, MX125-

MKC-M10, MX114-PLS-M10, etc.) for the DO, DI, and PWM modules.
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3.	 Click the Current Configuration tab followed by the Reconfigure based on actual 
config. button.
A dialog box with the message “Module settings which do not match the current software 
configuration will be initialized.” appears.

					   

Click here Click here

Note
If the × mark remains even after reconfiguring the system numerous times, see the corrective 
action described for “The connected input/output module is not detected” in section 5.1.

4.	 Click the OK button.
The current module configuration is matched to the actual configuration.

					   

Current module configuration

Setting the A/D Integration Time
1.	 Click System to show the System setup screen.

2.	 From the A/D Integration Time list box, select AUTO, 50 Hz, or 60 Hz.

					   

2.2  Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card
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MX100 Response Check
1.	 Click System to show the System setup screen.

2.	 Click the Execute button to the right of Response Check.
The 7-segment LED on the main module of the connected MX100 displays “--CALL--”

					   

Click here

Setting the Write Mode and Formatting the CF Card
1.	 Click System to show the System setup screen.

2.	 Click the Update button to the right of Compact Flash Information.
The most recent status of the CF card that is inserted in the card slot is displayed.

Setting the Write Mode
3.	 To save the file repeatedly by deleting the old file when the there is no more free 

space on the CF card, select the Cyclic Mode check box under Compact Flash 
Information > Write mode.
To stop the save operation when there is no more free space, clear the check box.

Format
3.	 Click the Execute button to the right of Format under Compact Flash Information. 

A confirmation message “Format Compact Flash?” appears.

	

Formats the 
CF card

Displays the 
latest status 
of the CF card

4.	 Click the OK button.
The message “Format was successful.” appears.

					   

2.2  Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card
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	 While the CF card is being formatted, the 7-segment LED of the main module 
displays the following. 

					   

Explanation
Items That Can Be Confirmed on the System Screen
•	 Unit Setup
	 You can check the model, version, serial ID, option, temperature unit, and the A/D 

integration time.
•	 Module Arrangement
	 If you click the Current Configuration tab, the attachment conditions (attachment 

positions and types) of the input/modules identified by the software are displayed.
	 If you click the Actual Configuration tab, the attachment conditions of the actual input/

output modules are displayed.
•	 Network Information
	 You can check the machine name, IP address, subnet mask, default gateway, port 

number, and MAC address.
•	 Compact Flash Information
	 You can check the status, maximum size, and free area of the CF card inserted in the 

card slot.
	 The CF card status indicates the following:

None	:				     The CF card is not inserted in the slot.
Exists (Usable)	:	  The CF card is inserted in the slot and usable.
Exists (Unusable): The card is inserted in the slot but unusable due to reasons such 

as an unformatted card, unsupported file system, or broken card.

			 

Check the unit setup

Check the network information Check the CF card information

Check the module information
(system reconfiguration is possible)

2.2  Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card
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Setting the A/D Integral Time
When the measurement interval is one of the setting values in the table below, the A/D 
integral time setting of the input module becomes active. The default setting is AUTO.
•	 AUTO
	 Automatically sets the A/D integral time to 50 Hz or 60 Hz according to the frequency 

of the power supplied to the main module.
•	 50 Hz
	 Sets the integral time to 20 ms.
•	 60 Hz
	 Sets the integral time to 16.67 ms.

Input Module Type Measurement 
Interval Setting

4-CH, High-Speed Universal Input Module (MX110-UNV-H04) 50 ms
10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10) 500 ms
30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30) 1 s
6-CH, Medium-Speed Four-Wire RTD Resistance Input Module  
(MX110-V4R-M06) 500 ms

4-CH, Medium-Speed Strain Input Module  
(MX112-B12-M04, MX112-B35-M04, and MX112-NDI-M04) 200 ms

* For the A/D integral times when setting other measurement intervals, see chapter 4, 
“Specification” in the MX100 Data Acquisition Unit User’s Manual” (IM MX100-01E).

Setting the Write Mode of the CF Card
If the connection between the software and the MX100 is dropped while the measured/
computed data is being recorded (see section 2.7), the measured data is saved (backed 
up ) to the CF card on the main module. If the Cyclic Mode check box is selected and 
measured data is saved in backup mode, the data continues to be saved by deleting 
the oldest data file when there is no more free space on the CF card. If the check box is 
cleared, data saving stops when there is no more free space on the CF card.

2.2  Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card
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2.3	 Setting the Acquisition Conditions of the 
Measured/Computed Data

Procedure

Setting the Monitor Interval and Record Interval of Measured Data
1.	 Click Acquisition to show the Acquisition setup screen.

					   

Click here

2.	 Drag and drop the input module icon within the Measurement Group 1, 
Measurement Group 2, or Measurement Group 3 frame.
Drag the input module with the same monitor interval to the same measurement group. Drag 
the input modules that are not to make measurements to the Unused Modules frame. Only 
the Monitor interval list boxes and the Rec. interval boxes of the measurement groups that 
contain input modules are activated.

					   

Drag and drop the icon of the input
module to a measurement group.

3.	 Select the monitor interval (measurement interval) from the Monitor Interval list 
box. 

4.	 Enter the record interval (integer multiplication factor) in the Rec. Interval text box.

					   

Select the monitor interval of each interval group
The selectable monitor interval varies depending on the types of
modules assigned to the same group and the measurement range.

Set using an integer multiple of the monitor interval for each interval group (up to 128).
The recording to the data file is carried out at (monitor interval × multiplication factor).
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Setting the Record Interval of Computed Data
1.	 Click Acquisition to show the Acquisition setup screen.

2.	 Enter the record interval (integer multiplication factor) in the Rec. Interval text box.

Automatically set to the minimum monitor interval of
the interval group with modules assigned or 100 ms,
whichever is less (cannot be changed).

Set using an integer multiple of the monitor interval
for each computation group (up to 128)
The recording to the data file is carried out at
(monitor interval × multiplication factor).

Setting the Record Start and Stop Conditions and Resetting Computation
1.	 Click Acquisition to show the Acquisition setup screen. 

2.	 Select On Record, Fixed Time, or Math under Start Condition.
If you select Fixed time, enter the start date/time.

3.	 Select Manual, Fixed Time, Fixed Period or Math under Stop Condition.
If you select Fixed time, enter the stop date/time.
If you select Fixed period, enter the record time.

					   

Start recording immediately
Select the record start condition

Start recording when the specified time is reached
Start recording when the specified condition (see the 
explanation in this section) is met in the equation
Record continuously (stop by pressing the Stop 
button on the Monitor screen)
Stop recording when the specified time is reached
Stop after recording the time interval specified here
Stop recording when the specified condition (see the 
explanation in this section) is met in the equation

Select the record stop condition

4.	 To reset the computed results at the same time recording is started, select the 
Math Clear on Start check box.

					   

2.3  Setting the Acquisition Conditions of the Measured/Computed Data
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Setting the Record File
1.	 Click Acquisition to show the Acquisition setup screen.

2.	 Enter the save destination of the file in the Folder box.
If you click the folder icon, the Browse for Folder dialog box opens, and you can select 
the save destination folder. To do so, click the New Folder button, enter the folder name to 
create a new folder within the save destination folder, and then set it as the save destination.

3.	 Enter the name of the record file in the File Name box.
To add the record date information to the specified file name, select the Add Date check 
box. To add the record time information to the specified file name, select the Add Time check 
box. If both check boxes are selected, both the record date and record time information are 
added to the specified file name.
If a file with the same name already exists, a hyphen and a four-digit sequence number 
starting with 0000 is added to the end of the file name.

4.	 To record the data by changing the file every specified time interval, choose Fixed 
Period under File Division and enter the time.

5.	 To attach a comment to the file, enter the comment string in the Comment box.

File save destination
To select the save destination
from the Browse for Folder
dialog box, click the folder
icon.

Browse For Folder dialog box

Click and enter the folder name to create a
new folder within the save destination folder

Name of the record file
Select the check box when
adding the record date/time
information to the specified
file name
The time when data is recorded to
a new file every specified time interval
File comment (up to 127 characters)
Displayed in the file information dialog box* 
that appears when printing data on Viewer

* Displayed by choosing Information > File Information in Viewer.

2.3  Setting the Acquisition Conditions of the Measured/Computed Data



2-17IM MX180-01E

Integration M
onitor

3

2

1

4

5

App

Index

Explanation
Monitor Interval
Sets the measurement interval, monitor update interval, and alarm detection interval. 
However, if the specified monitor interval is short, the data monitor update interval may 
be slower depending on the PC environment.
If the monitor interval is set greater than or equal to two minutes, the Integration Monitor 
acquires data from the MX100 at the specified interval, but the measurement interval and 
alarm detection interval on the MX100 are one minute.
The input modules can be divided into three interval groups, and different monitor 
intervals can be specified for each interval group.

Note
The shortest interval that you can specify for the monitor interval is the longest of the shortest 
measurement intervals of all the input modules assigned to the same measurement group. 
For example, if an input module with the shortest measurement interval of 10 ms and an input 
module with 100 ms are assigned, 100 ms is the shortest interval that can be specified for the 
group.
When saving backup data to the CF card, for monitor intervals of up to one minute, the data 
is saved at the monitor interval, and for monitor intervals of two minutes or more, the data is 
saved at one-minute intervals.

Record Interval of Measurement Channels
The record interval is the interval at which the data of measurement channels is saved to 
a PC hard disk. It is set as an integer multiple of the monitor interval (up to ×128).

Monitor Interval and Record Interval of Computation Channels
The monitor interval of computation channels is the minimum monitor interval of the 
interval group or 100 ms, whichever is greater. The record interval is set as an integer 
multiple of the monitor interval (up to ×128).

Note
Computation channels are not saved to the CF card.

Record Start Condition
Select the start condition for saving the data of measurement/computation channels from 
the following.
•	 On Record
	 Immediately starts recording when the Record button on the Monitor screen is clicked 

or Record is chosen from the Acquisition menu.
•	 Fixed Time
	 Starts recording at the specified date/time. Set the date/time as “year/month/day/

hours:minutes:seconds” If the specified time has already been passed, the operation 
is the same as On Record.

•	 Math
	 Starts recording when the StartRec() event function (see “Event Function” under 

“Explanation” in section 2.5) is executed on a computation channel. This is valid when 
you click the Record button on the Monitor screen (see section 2.7) and the word 
“Waiting” is displayed.

2.3  Setting the Acquisition Conditions of the Measured/Computed Data
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Record Stop Condition
Select the condition for stopping the recording from the following: 
•	 Continuous
	 Immediately stops recording when the Stop button on the Monitor screen is clicked or 

Stop is chosen from the Acquisition menu.
•	 Fixed Time
	 Stops recording at the specified date/time. Set the date/time as “year/month/day/ 

hours:minutes:seconds” If the specified time has already been passed, the operation 
is the same as Manual.

•	 Fixed Period
	 Stops recording after the specified time elapses after the recording is started. Set the 

time as “hours:minutes:seconds”
•	 Math
	 Stops recording when the StopRec() event function (see “Event Function” under 

“Explanation” in section 2.5) is executed on the computation channel.

Save Destination and Name of the Record File
Select the hard disk drive of your PC for the save destination. By default, the save 
destination is the Data folder in the MX100 Standard folder where the MX100 Standard 
Software is installed.

 Note
Do not set the save destination to a storage medium other than the hard disk or to a network 
drive. Doing so may cause problems in terms of performance.

The default file name is “data” If multiple files are created, the name is “data-XXXX”(where 
XXXX is a four-digit sequence number starting with 0000). The extension is .mxd. You 
can also add the file creation date and time to the file name as follows. 
•	 When adding both the date and time: data-0224-1316 (recording started at 13 hours 

and 16 minutes on February 24)
•	 When only the date is added: data-20080224 (recording started on February 24, 

2008) 
•	 When only the time is added: data-1319 (started recording at 13 hours 16 minutes)
If a file with the same name already exists, a hyphen and a four-digit sequence number 
starting with 0000 is added to the end of the file name.

File Division of Record Files
The file can be divided every specified time interval. Set the time as “hours:minutes:
seconds”
Even if file division is not specified, the file is automatically divided when the size of a 
single file exceeds approximately 1 GB or when the number of data points of any of the 
channels in the file exceeds 2 million.

Number of Characters That Can Be Entered for the Comment of the 
Record File
The maximum number of characters that can be entered is 127.

Selecting the Channel to Be Recorded
You can specify recording/no recording on individual channels. The settings are as 
follows.
•	 Measurement channels: �2.4, “Setting the Measurement Conditions (Setting the 

Measurement Channels)”
•	 Computation channels: �2.5, “Setting Computations (Setting the Computation 

Channels)”

2.3  Setting the Acquisition Conditions of the Measured/Computed Data



2-19IM MX180-01E

Integration M
onitor

3

2

1

4

5

App

Index

2.4	 Setting the Measurement Conditions (Setting 
the Measurement Channels)

Procedure

Turn ON/OFF collectively*3

When making the settings
the same as the first item*3

Reset to default*3 To copy*3

*3 Applied to the selected range by dragging the cursor. 
 Applied to all lines if a range is not selected.

*1  Excluding Tag No. and Tag comment
*2  Cannot be used when Mode is set to RRJC

Record check box

Icon of the attached modules
Point to the icon to display information 
about the module 
Click the icon to select the channels of 
the module 
(gray background and red characters)

Monitor check box
Select the input mode
If changed, the Range setting and 
others to its right are initialized*1

Select the measurement range
If changed, the Span setting and 
others to its right are initialized*1

Minimum/Maximum value of span
The Use check box for Scale*2

Decimal point position of the scale*2

Maximum/Minimum values of the scale*2

Click hereMeasurement channel tab

1.	 Click Channel to show the Channel setup screen.

2.	 Click Meas. Channel tab.

Setting the Measurement Channels for Recording and Monitoring
3.	 Select Record check boxes of the channels to record.

4.	 Select the Monitor check boxes of the channels to monitor.

Setting the Input Mode
5.	 Select the input mode from the Mode list box.

Setting the Measurement Range
6.	 Select the measurement range from the Range list box.

Setting the Measurement Span
7.	 Click the Min box or Max box under Span and enter the minimum or the maximum 

value of the span.
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Setting the Scale (Only When Scaling)
8.	 Select the Use check boxes under Scale to enable changing of the scale.

9.	 Select the decimal point position from the Point list box for Scale.

10.	Click the Min box or Max box under Scale and enter the minimum or the maximum 
value of the scale.

11.	 Click the Unit box and enter the unit of the scaled value.

Setting the Reference Channel for Difference Input (Valid Only When Measuring 
the Difference with Respect to the Measured Value of the Reference Channel)

12.	Select the Use check box under Difference Input.

13.	Select the reference channel for the difference input from the Ref. Ch. list box 
under Delta.

Setting the Remote RJC Reference Channel (Valid Only When the Input Mode Is 
Set to RRJC (TC)

14.	Select the reference channel for the remote RJC from the Ref. Ch. list box under 
RRJC.

Note
If moving from the Channel screen to the Display Setup or Monitor screen, if the differential 
input reference channel or remote RJC reference channel setting is inappropriate the following 
message appears.
Yes: �Disable measurement channels with inappropriate settings (clear the Monitor check box in 

the Channel screen) and move to the Display Setup or Monitor screen
No: �Change the settings of the measurement channels with inappropriate settings without 

moving to the next screen

		  Message

			 

Setting the Time Constant of the First-Order Lag Filter (Valid Only When the 
Input Mode Is Set to Something Other than DI)

15.	Select the time constant from the Filter list box.

Setting the Burnout (Valid Only When the Input Mode Is Set to TC)
16.	Select the direction in which the measured value is set off the range (+OVER or  

–OVER) when a burnout occurs from the Burnout list box.

Setting the RJC (When the Input Mode Is Set to TC)
17.	Click the Type box under RJC and select Internal or External.

18.	If you select External, click the Volt box under RJC and enter the compensation 
voltage.

2.4  Setting the Measurement Conditions (Setting the Measurement Channels)
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Select the reference channel for difference input*

Enter the tag comment (up to 30 characters)

Unit (up to six characters, only when the Use check box of Scale is selected)
Enter the tag number (up to 15 characters)

Select the remote RJC reference channel (only when the input mode is set to RRJC (TC))

Check here to measure the difference input (difference with respect to
the measured value of the reference channel)*

* Cannot be used when Mode is set to RRJC

Set the RJC (only when the input mode is
set to something other than DI)

Set the burnout (only when the input mode is
set to something other than DI)

Set the time constant of the first-order lag filter
(when the input mode is set to something other than DI)

Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and 
replace the current tag numbers and tag comments with the imported information. 
From the File menu, choose Import Tag. Then, select an MX100 project file (a file with 
the .mxp extension) in the Open dialog box to import the tag numbers and tag comments.

		

Select the MX100 project file (file with .mxp extension)
you wish to import

Note
When you carry out the procedure above, the tag numbers and tag comments of computation 
channels are also imported.

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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Set the initial balance for strain input channels 
(only when the input mode is set to STR)

Set the type for alarms 1 to 4, the setting value, 
and the hysteresis (see section 2.9)

Set the Initial Balance for Strain Input Channels (Only When the Input Mode Is 
Set to STR)

19.	Under Strain function, click the Execute button under Initial balance or Reset.
The Executing Initial balancing dialog box appears, and Executing is displayed in the Status 
box. When execution is complete, the result is displayed in the Status box.

					   

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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Note
•	 You can execute initial balancing and reset the initial balance value on multiple recording 

channels at once by selecting the channels and clicking the collective execution button.

					   

Drag and drop channels on which to perform initial balancing to select them
Selected channels are displayed with red characters against a gray background 

Collective execution ON/OFF button

•	 To execute initial balancing on a strain input module, you must finalize MX100 channel 
settings and send them. If invalid channel settings are entered, a dialog box will appear 
prompting you to correct the settings.

		  Message

					   

 

Initializing, Copying, and Pasting of Settings on the Display Setup Screen
The procedures are the same as those for Initializing, Copying, and Pasting of Settings 
on the Display Setup Screen described in section 2.6.

Explanation
Input Mode and Measurement Range
Measurement channel settings differ depending on the hardware style number of the 
MX100. See the table below.
Connectable module types 
or setting items

MX100 Hardware 
Style Number*

Notes

S3 S2 S1
30ch module  
MX110-VTD-L30

Yes No No –

GOST range Yes No No Can be set only for MX110-UNV-M10, 
MX110-UNV-H04, MX110-V4R-M06, and 
MX110-VTD-L30

Yes: Setting and operation allowed, No: Setting and operation not allowed
*  The style number is printed on the MX100 main module name plate.

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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On the channels of the input module, select from the modes below according to the input 
signal. For details of the measurable range, measurement accuracy, and resolution, see 
chapter 4, “Specification” in the MX100 Data Acquisition Unit User’s Manual (IM MX100-
01E).
•	 VOLT (DC voltage)
	 Select the measurement range from 20 mV, 60 mV, 200 mV, 2 V (default), 6 V, 20 V, 

or 100 V.

Note
Current input is possible by attaching a shunt resistor to the input terminal and converting to voltage 
input. The shunt resistors in the table below are available for purchase separately. For example, a 
250 Ω shunt resistor is used to convert the signal in the range of 1 to 5 V for 4 to 20 mA input.
Part Name Model Resistance
Shunt resistor  
(for clamp terminal)

415920
415921
415922

250 Ω ± 0.1%
100 Ω ± 0.1%
10 Ω ± 0.1%

Shunt resistor  
(for screw terminal)

438920
438921
438922

250 Ω ± 0.1%
100 Ω ± 0.1%
10 Ω ± 0.1%

•	 TC (thermocouple), on the Universal Input Module and 30-CH, Medium-Speed 
DCV/TC/DI Input Module

	 Select the thermocouple type (referred to as Range in the setup) from Type-R (default), 
Type-S, Type-B, Type-K, Type-E, Type-J, Type-T, Type-N, Type-W, Type-L, Type-U, or 
KpvsAu7Fe.

•	 RTD1 (resistance temperature detector, measured current: 1 mA), on the 4-CH, 
High-Speed Universal Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100 (high resolution Pt100), HQ JPt100 (high-resolution JPt100), Ni100:SAMA, 
Ni100:DIN, or Ni120.

•	 RTD1 (resistance temperature detector, measured current of 1 mA), on the 
10-CH, Medium-Speed Universal Input Module/6-CH, Medium-Speed Four-Wire 
RTD Resistance Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Ni100:SAMA, 
Ni100:DIN, Ni120, Pt50, Cu10:GE, Cu10:L&N, Cu10:WEED, Cu10:BAILEY, or J263B.

•	 RTD2 (resistance temperature detector, measured current: 2 mA), on the 4-CH, 
High-Speed Universal Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Pt50, Cu10:
GE, Cu10:L&N, Cu10:WEED, Cu10:BAILEY, or J263B.

	 The RTD2 selection is not available on the 10-CH, Medium-Speed Universal Input 
Module and the 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module.

•	 RTDEX (resistance temperature detector, measured current: 0.25 mA), on the 
6-CH, Medium-Speed Four-Wire RTD Resistance Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt500 (default setting) or 
Pt1000.

•	 OHM (resistance), on the 6-CH, Medium-Speed Four-Wire RTD Resistance Input 
Module

	 Select a measurement range of  20 ohm (measured current: 1 mA), 200 ohm (measured 
current: 1 mA), or 2 kohm (measured current: 0.25 mA).

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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•	 DI (digital input), on the 10-CH, Medium-Speed Digital Input Module
	 Only the DI (digital input) setting is available for the input type. Select LEVEL (D10) 

(voltage input) for -D05, or CONTACT (D10) (non-voltage contact input) for the 
measurement range to match the input. For -D24, only LEVEL (24 V) is available.

•	 DI (digital input), on the 4-CH, Medium-Speed Universal Input Module
	 Select LEVEL (voltage input) or CONTACT (HS) (non-voltage contact input) to match 

the input.

•	 DI (digital input), on the 10-CH, Medium-Speed Universal Input Module, 30-CH, 
Medium-Speed DCV/TC/DI Input Module, 6-CH, Medium-Speed Four-Wire RTD 
Resistance Input Module

	 Select LEVEL (voltage input) or CONTACT (SC) (non-voltage contact input) to match 
the input.

•	 STR (strain), on the 4-CH, Medium-Speed Strain Input Module
	 Select a measurement range of 2000 μSTR, 20000 μSTR (default), or 200000 μSTR. 

•	 RRJC (TC)
	 RRJC (TC) refers to temperature measurement using a thermocouple. Select a 

channel when referring to the temperature of a relay terminal (the temperature input 
of the relay terminal is specified at RRJC Ref. Ch.). When the item to be measured 
is located at a great distance, you can setup relay terminals near the item to be 
measured to make temperature measurements without having to use large quantities 
of high-cost thermocouples. Connect the item to be measured and the relay terminal 
using a thermocouple; connect the relay terminal and the MX100 using a copper wire. 
By connecting one terminal of the MX100 and the relay terminal using a thermocouple 
and measuring the temperature of the relay terminal, reference junction compensation 
is carried out on the temperature measurement and the temperature measurement on 
the item is made.

			 

MX100
Thermocouple*

Copper wire

Copper wire

Thermocouple*

Thermocouple*

Relay terminal (to be furnished by the user)

Reference channel

In
pu

t t
er

m
in

al

* Use the same type of thermocouples.

Setting the Measurement Span
Set the minimum and maximum values of the range that is actually measured within the 
measurable range.

Setting the Scale
Set this item when linearly scaling the measured values. Set the scale by entering the 
maximum and minimum values corresponding to the maximum and minimum values of 
the measurement span and selecting the decimal point position of the scaled value (see 
the figure below). The selectable range of the scale is –30000 to 30000. The decimal 
point position can be set to 4 (X.XXXX), 3 (XX.XXX), 2 (XXX.XX), 1 (XXXX.X), or 0 
(XXXXX).In addition, a unit can be assigned to the scaled value.
You can set the unit using up to six characters.

		

0 3 [V]0

100

Span minimum
Scale minimum

Span maximum

Scale maximum

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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Setting the Reference Channel for Difference Input
Set this item when making the difference between the measured value of the channel 
and the measured value of the reference channel the measured value (referred to as 
difference computation). The reference channel can be set to a channel that is scaled.
Difference computation can be executed even if the measurement range of its own 
channel and that of the reference channel are not the same.
If the decimal point position setting is different between its own channel and the reference 
channel, the decimal point position of the measured value of the reference channel is 
matched to that of its own channel, and the difference is computed.
Example: 	When the measured value of the channel set to difference input is 10.00 and 

the measured value of the reference channel is 100.0
		  The computed result is 10.00 – 100.0 = –90.00.
Set the reference channel for difference input to a measurement channel that has the 
Monitor check box selected.

Setting the Remote RJC Reference Channel (Valid Only When the Input 
Mode Is Set to RRJC (TC)
This item sets the reference channel when the input mode is set to RRJC (TC).
Set the reference channel for remote RJC to a channel that meets the two conditions 
below.
•	 The reference channel is a measurement channel (channel existing on the 

measurement channel tab) with the Monitor check box selected.
•	 The range of the reference channel and that of the corresponding measurement 

channel are the same.

Setting the Time Constant of the First-Order Lag Filter (Valid Only When 
the Input Mode Is Set to Something Other than DI)
A first-order lag filter is available. Select a time constant N (time until 63.2% of the output 
value is reached) from the Filter list box for the case when the measurement interval 
(Monitor interval in the settings) is set to 1 s. Time constants when the measurement 
interval is set to a value other than 1 s follow the equation below.
Time constant = measurement interval × N (where N = 5, 10, 20, 25, 40, 50, or 100)
The table below lists the relationship.
Measurement 
Interval (s) Selectable Time Constants (s)

0.01 0.05 0.1 0.2 0.25 0.4 0.5 1
0.05 0.25 0.5 1 1.25 2 2.5 5
0.1 0.5 1 2 2.5 4 5 10
0.2 1 2 4 5 8 10 20
0.5 2.5 5 10 12.5 20 25 50
1 5 10 20 25 40 50 100
2 10 20 40 50 80 100 200
5 25 50 100 125 200 250 500
10 50 100 200 250 400 500 1000
20 100 200 400 500 800 1000 2000
30 150 300 600 750 1200 1500 3000
60 300 600 1200 1500 2400 3000 6000

		

Input
63.2% of the output value

Output curve when
the filter is used

Time constant in the table above

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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Setting the Burnout
When the input mode is set to TC, you can set the burnout detection behavior. If set 
to Up, the measured value is fixed to +OVER when a burnout is detected (condition in 
which the input signal level exceeds the upper limit of the measurement range). If set to 
Down, the measured value is fixed to +OVER (condition in which the input signal level 
exceeds the lower limit of the measurement range). To not detect burnouts, select Off 
(default).

Setting the RJC
When the input mode is TC, select whether to use the internal reference junction 
compensation function of the input module or an external reference junction 
compensation function. (This setting is possible when the input mode is set to a mode 
other than DI, but the setting takes effect only when the mode is TC.) When using the 
external reference junction compensation function, set an appropriate reference junction 
compensation voltage (Volt in the setup) in the range of –20000 µV to 20000 µV. For 
example, if the reference junction temperature of the external reference compensation is 
T0°C, set the reference compensation junction voltage to the thermoelectromotive force 
of the 0°C reference of T0°C.

Initial Balancing of Strain Input Channels (Initial Unbalance Value 
Adjustment)
When configuring a bridge circuit with a strain gauge, the bridge circuit will not 
necessarily be balanced even if the strain of the circuit under test is zero due to the slight 
deviation in resistance of the strain gauge, and the measured value may not be zero (the 
value in such cases is called the initial unbalanced value).
Therefore, when taking measurements you must first balance the bridge and, if the strain 
is zero, obtain a measured value of zero. This is called initial balancing. (setting the initial 
unbalanced value to zero).

		

Measured value

Strain

Initial unbalanced value

Reset

Initial balance

0

With the MX100, initial balancing is performed in the ±10000µ strain range.
Initial balance: 	 The value when the command is executed is set as the initial 

unbalanced value, and the measured value is set to zero.
Reset: 	 The value set during initial balancing is reset to zero. The initial 

unbalanced value is used as-is for the measured value.

Note
If the measuring range is changed, the initial balancing is reset.
After a range change, you must redo initial balancing.

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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The results of initial balancing are as follows.
Status box display Status
----- Not executed
Successful Initial balancing was executed successfully.
Failed Initial balancing failed.
OVER Initial balancing succeeded, but the output value exceeded the upper 

limit or fell below the lower limit, and the value was rounded to the 
upper limit value or the lower limit value.

Executing Executing initial balancing

Note
If initial balancing fails, “  ” is displayed in the 7-segment LED on the main module.
Check the installation status of the strain input module and perform the initial balancing again. 
If the error occurs even after rebalancing, servicing is required. Please contact your nearest 
Yokogawa representative.

Scaling Settings When Using a Strain Gauge Type Sensor
The following is an explanation of scaling settings used when measuring physical 
quantities such as load and length with a strain gauge type sensor.

The basic relational expression is as follows.

	 1 mV/V = 2000 µstrain (Equation 1)

Two examples are given below: 1) when rated input and output are listed in the user’s 
manual of the strain gauge type sensor, and 2) when listed with the calibration coefficient. 
(hereinafter, “µstrain” will be expressed as “µStr.”)

When Rated Input and Rated Output Are Given
A specific example is given below.
•	 Rated input	 200 N		  (set to Y)
•	 Rated output	 0.985 mV/V	 (set to K)

In this case, these figures indicate that if a 200 N load is applied, 0.985 mV/V is output.

From the relationship in equation 1, if 200 N is applied,
an output of 0.985 mV/V=0.985×2000=1970 µSTR is attained.

In other words, for each 1 N, 1970 µSTR/200N= 9.85 µSTR/N is output.
Therefore, the scaling settings are entered as follows.

When Measuring at 50-150 N
	 Scale minimum: 50	 (units: N) (set to Smin)
	 Scale maximum: 150	 (units: N) (set to Smax)
therefore, 

	 Span minimum: 50×9.85mSTR/N = 492.5 µSTR
	 Span maximum: 150×9.85 =1477.5 µSTR 

...can be set.

Thus, the measuring range is 2000 µSTR.

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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Generally, the range is as follows.
Using the symbols that have appeared in the explanation thus far, after setting the scale 
maximum and minimum, the values are as follows.

	 Span minimum = [(K(mV/V) × 2000) / Y(unit)] × Smin (µSTR)
	 Span maximum = [(K(mV/V) × 2000) / Y(unit)] × Smax (µSTR)

When Listed at the Calibration Coefficient
An example is given with a displacement gauge.
•	 Rated input				    20 mm
•	 Calibration coefficient	 0.003998 mm / (1 µV/V)

 Basically, if you can convert the calibration coefficient to the rated output mentioned in 
“When Rated Input and Rated Output Are Listed,” the following is a calculation following 
the explanation in “When Rated Input and Rated Output Are Given.”

Using equation 1,
	 1mV/V = 0.001mV/V = 0.001 × 2000 µSTR = 2 µSTR
therefore the rated output with this sensor when 20 mm is input would be 

	 20 mm ÷ 0.003998 mm / 2 µSTR] = 10005 µSTR

In other words, for each 1 mm, an output of 
	 10005 µSTR / 20mm = 500.25 µSTR/mm

can be obtained.

Thereafter in the same manner, if you wish to measure with a scale of 2 mm to 15 mm, 
the settings are:
	 Scale minimum: 		 2
	 Scale maximum: 	 15 (units: mm)
therefore, 
	 Span minimum: 		 2 × 500.25 µSTR/mm = 1000.5 µSTR
	 Span maximum: 		 15 × 500.25 µSTR/mm = 7503.75 µSTR

...would be appropriate settings.

The measuring range becomes 20000 µSTR, making the resolution on the MX100 1 
µSTR, therefore we can round as follows.

	 Span minimum: 1001 µSTR
	 Span maximum: 7504 µSTR

2.4  Setting the Measurement Conditions (Setting the Measurement Channels) 
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2.5	 Setting Computations (Setting the Computation 
Channels)

Procedure

Minimize button

Used for output channel scaling 
and the initial value of the span for 
the General Display screen. 

Enter the equation 
(up to127 characters, not 
case sensitive)
Equations that are appropriate are 
displayed in black Equations that are 
inappropriate are displayed in peach

Specifies the decimal places for the 
minimum/maximum value of span

Click hereMath Channel tab

Monitor check box
Record check box

1.	 Click Channel to show the Channel setup screen.

2.	 Click the Math Channel tab.

Setting the Computation Channels for Recording and Monitoring
3.	 Select Record check boxes of the channels to record.

4.	 Select the Monitor check box of the channels to monitor.

Setting the Equation
5.	 Click the Expression box, and enter the expression.

Setting the Computation Span
6.	 Specify a number of digits in the Decimal Places list box for Span that is less than 

or equal to that of the maximum and minimum values.

7.	 Click the Min box or Max box next to Span and enter the minimum or the 
maximum value of the span.
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Alarm settings 
(see section 2.9)

Enter the unit of the computed 
value (up to 6 characters)
Enter the tag number 
(up to 15 characters)

Enter the constant value

Enter the label for identifying 
the constant
Appropriate labels are displayed 
in black Inappropriate labels are 
displayed in peach

Enter the tag comment 
(up to 30 characters)

Note
Sixty computation channels are always shown.

Setting the Unit, Tag Number, and Tag Comment
8.	 Click the Unit, Tag No., and Tag Comment text box and enter the unit, tag number, 

and tag comment, respectively.

Setting the User-Defined Constant
9.	 Click the Label box under Constant and enter a label for identifying the constant.

10.	Click the Value box under Constant and enter the value of the constant.

Importing Equations
You can import saved expressions from a file. From the File menu, choose Import Math 
Expression. Then, select an MX100 project file (a file with the .mxp extension) in the 
Open dialog box. Only saved expressions can be imported.

		

Select the MX100 project file (file with .mxp extension)
you wish to import

2.5  Setting Computations (Setting the Computation Channels)
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Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and 
replace the current tag numbers and tag comments with the imported information. From 
the File menu, choose Import Tag. Then, select an MX100 project file (a file with the .mxp 
extension) in the Open dialog box to import the tag numbers and tag comments.

		

Select the MX100 project file (file with .mxp extension)
you wish to import

Note
When you carry out the procedure above, the tag numbers and tag comments of measurement 
channels are also imported.

Importing User-Defined Constants
On the File menu click Import Tag, then select an MX100 project file (a file with an 
.mxp extension) in the Open dialog box to import just the saved tag numbers and tag 
comments.

		

Select the MX100 project file (file with .mxp extension)
you wish to import

2.5  Setting Computations (Setting the Computation Channels)
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Setting Timers (Only When Using Timers in the Computations)
11.	 Click Action for a timer and select Edge or Level.

When not using the timer, select Off (default).

12.	Click the Interval box, and enter the interval.

13.	If Action was set to Edge, click the On-period box and enter the time interval over 
which the timer is to be turned ON. If Action was set to Level, click the On-period 
or Off-period box and enter the time over which the timer is turned ON or OFF.

					     If Action is set to Level, enter the time interval over which
the timer is OFF.

If Action is set to Edge or Level, enter the time interval over which
the timer is ON.

Set the timer interval

Minimize
button

To use a timer in the computation, select Edge or Level
When not using the timer, select Off (default).

When Calculating ±Overrange Values of Measurement Channels as the Maximum 
and Minimum Values of the Measurement Range

14.	Select the Calculate +Over/–Over as the MAX/MIN value of the measurement 
range check box.

					   

Check here to calculate +Over and –Over as maximum and minimum values of the measurement range

Resetting the Computations
From the Action menu, choose Math Clear.

			 

2.5  Setting Computations (Setting the Computation Channels)
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Explanation
Computation Overview
You can enter computation equations using the constants, operators, and functions 
described below. The computed results can be displayed and recorded (saved) as 
computed data. Computation allows you to determine the average/maximum/minimum 
of a specified channel on a specified date/time, or output events (start/stop record, reset 
time, etc.) under specified conditions. The number of available computation channels is 
60 (channel numbers 99001 to 99060), and the number of characters that can be used in 
the equation is 127.

Constants
The following three types of constants can be used.
•	 User-defined constants
	 A constant can be assigned to an arbitrary string (name). You can set up to sixty user-

defined constants. Set the Name of the constant using a string (up to ten characters) 
that is not used by predefined constants or functions. They are not case-sensitive. 
The precision and range of the constant values are the same as the single-precision 
floating point format (32 bits, negative values: –3.4028235E+38 to –1.401298E–45, 
and positive values: 1.401298E–45 to 3.4028235E+38).

•	 Predefined constants
	 The five strings below are used for predefined constants. They are not case-sensitive.

•	 NaN:	 Represents an invalid value or error value. For a description of the 
computed result when NaN is used in the computation, see “Notes on 
Computation” in this section.

•	 POver:	 Represents +Over (positive overrange). The expression POver > x is 
satisfied for any arbitrary value x.

•	 MOver:	 Represents –Over (negative overrange). The expression MOver < x is 
satisfied for any arbitrary value x.

•	 Pi:	 Represents the ratio of the circumference (3.14...).
•	 e:		 Represents the base of the natural logarithm (2.718...).

•	 Numeric constants
	 Numeric values that are written directly in the equation. They are expressed in the 

following form.
	 [digits][.digits][{d|D|e|E}[digits]]
	 Example: 1.0d+1 represents 10.0.

Channel Numbers
Channel numbers can be used to specify the <channel> (measurement or computation 
channels). The channel number is specified using five digits, the unit number in the 
highest two digits and the channel number within the unit in the lowest three digits. On 
the MX100 Standard Software, measurement channels are specified using 00001 to 
00060 (1 to 60 are also allowed). Measurement channels are specified using 990001 to 
99060.

Tag Numbers
Tag numbers can be used to specify the <channel> (measurement or computation 
channels). The tag numbers are enclosed in double quotation marks as in “TagNo.00001” 
They are case-sensitive.

Note
If the same tag number is specified on multiple channels, proper operation is not guaranteed.

2.5  Setting Computations (Setting the Computation Channels)
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Manual Output, and User Output (DO Channels, AO Channels, and PWM 
Channels)
Specify an integer starting with 1. The arguments for the ManualDO() and ManualAO() 
functions are as follows.
<ManualDONo.>			  1-4
<ManualAONo.>			  1

Operators
The operators listed below can be used.
Operator	Description	 Example
+	 Unary plus operator	 +ch(00010)
–	 Unary minus operator	 –ch(00010)
!	 Logical negation operator, 1 when 0 and 0	 !ch(00010)
	 when non-zero	

+	 Addition	 ch(00010)+ch(00011)
–	 Subtraction	 ch(00010)–ch(00011)
*	 Multiplication	 ch(00010)*ch(00011)
/	 Division	 ch(00010)/ch(00011)
%	 Remainder	 ch(1)%ch(2)<=1 ? AlarmAck() : 0
<	 Less than, 1 when the condition is met and 0	 ch(1) > ch(2) ? AlarmAck() : 0
	 when it is not

>	 Greater than, 1 when the condition is met and 0	 ch(1) < ch(2) ? AlarmAck() : 0
	 when it is not

<=	 Less than or equal to, 1 when the condition is	 ch(00010)<=1.0 ? StartRec() : 0
	 met and 0 when it is not

>=	 Greater than or equal to, 1 when the condition	 ch(00010)>=1.0 ? StartRec() : 0
	 is met and 0 when it is not

==	 Equal to, 1 when the condition is met and 0	 ch(00010)==1.0 ? StartRec() : 0
	 when it is not

!=	 Not equal to, 1 when the condition is met and 0	 ch(00010)!=0 ? StartRec() : 0
	 when it is not

&&	 Logical product	 ch(1) && ch(2)==1 ? AlarmAck() : 0
||	 Logical sum	 ch(1) || ch(2)==1 ? AlarmAck() : 0
^^	 Exclusive OR	 ch(1) ^^ ch(2)==1 ? AlarmAck() : 0
? :	 Conditional operator	 ch(00010)>=1.0 ? StartRec() : 0	
	 (Write a ? b : c to mean b if a is met and c if not met)
,	 Order operator	 Condition?(ResetTimer(), StartRec() : 0

The order of precedence of the operators is as follows.
+ – ! (unary operators) ← + – * / % (arithmetic operators) ← < > <= >= == != (relational 
operators) ← && || ^^ (logical operators) ← ? (conditional operator) ← ,(order operator)
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Reference Functions and TLOG Functions
The function below are used to retrieve measured values and alarm values. The 
functions are not case sensitive. For the format used to specify the <channel>, <alarm 
level>, and <manual>, see “Procedure” in this section.
Function	 Description	 Example
ch(<channel>)	 Returns the current value of the specified channel	 ch(00001)/ch("Tag") 
	 (see “Channel Number” under “Explanation” in this 			 
	 section)
prech(<channel>)	 Returns the previous value of the specified channel	 prech(00001)/
	 (see “Channel Number” under “Explanation” in this 	 prech("Tag")	
	 section)

alarm(<channel>,	 Returns the alarm value of the specified channel and	 alarm(00001,2)/
<alarm level>) 	 specified alarm level, ON=1, OFF=0	 alarm("Tag",2)

alarm(<channel>)	 Returns the alarm value of the specified channel,	 alarm(00001)/
	 ON=1, OFF=0	 alarm("Tag")

alarm()	 Returns the alarm value of any channel,	 alarm()==1 ?
	 ON=1, OFF=0	 StartRec() : 0

tlogmax(<channel>)	 Returns the maximum value of the TLOG computation	 tlogmax(00001)/
	 of the specified channel	 tlogmax("Tag")

tlogmin(<channel>)	 Returns the minimum value of the TLOG computation	 tlogmin(00001)/
	 of the specified channel	 tlogmin("Tag")

tlogpp(<channel>)	 Returns the (maximum value – minimum value) of	 tlogpp(00001)/	
	 the TLOG computation of the specified channel	 tlogpp("Tag")
tlogsum(<channel>)	 Returns the sum of the TLOG computation of the	 tlogsum(00001)/
	 specified channel	 tlogsum("Tag")

tlogave(<channel>)	 Returns the average value of the TLOG computation	 tlogave(00001)/
	 of the specified channel	 tlogave("Tag")

ManualDO	 Returns the values being output on the specified 	 ManualDO(1)	
(<manual>)	 ManualDO.
ManualAO 	 Returns the values being output on an user output 	 ManualAO(1)	
(<manual>)	 channel.
*1	 The TLOG computation computes the maximum, minimum, maximum–minimum, sum, and 	
	 average values of the specified channel. If the TLOG function is present in the equation, the 	
	 computation is executed
*2	 The reference function or TLOG function returns NaN in the following cases.
	 •	 When the data to be referenced by the CH function or PRECH function does not exist 	
		  (when disconnected or immediately after starting the monitor operation)
	 •	� When the specified channel does not exist or when the specified alarm level is not 1, 2, 3, 

or 4.
	 •	 If the MX100 returns an INVALID value
*3	 Select the behavior taken when the value of the measurement channel is ±Over from the 	
	 following:	
	 •	 Continue the calculation as ±Over (behavior when the check box is not selected)
	 •	 Continue the calculation by setting ±Over to the maximum or minimum value of the 	
		  measurement range of the specified channel.
	 The selection is made using the Calculate +Over/–Over as the MAX/MIN value of a range 	
	 check box.

2.5  Setting Computations (Setting the Computation Channels)



2-37IM MX180-01E

Integration M
onitor

3

2

1

4

5

App

Index

Arithmetic Functions
Below are the arithmetic functions that are available. They are not case-sensitive.
Function	 Description	 Example
sin(<value>)	 Returns the sine of the <value>	 sin(ch("TagNo.00001"))
cos(<value>)	 Returns the cosine of the <value>	 cos(ch("TagNo.00001"))
tan(<value>)	 Returns the tangent of the <value>	 tan(ch("TagNo.00001"))
asin(<value>)	 Inverse sine	 asin(ch("TagNo.00001"))
acos(<value>)	 Inverse cosine	 acos(ch("TagNo.00001"))
sinh(<value>)	 Hyperbolic sine	 sinh(ch("TagNo.00001"))
cosh(<value>)	 Hyperbolic cosine	 cosh(ch("TagNo.00001"))
tanh(<value>)	 Hyperbolic tangent	 tanh(ch("TagNo.00001"))
pow(<value 1>, <value 2>)	 <value 1> to the power of <value 2>	 pow(ch(1),ch(2))
sqrt(<value>)	 Square root	 sqrt(ch(1))
logE(<value>)	 Natural logarithm	 logE(ch(1))
log10(<value>)	 Common logarithm	 log10(ch(1))
expE(<value>)	 e to the power of <value>	 expE(ch(1))
exp10(<value>)	 10 to the power of <value>	 exp10(ch(1))
abs(<value>)	 Absolute value	 abs(ch(1))
max(<value>,......,<value>)	 Maximum value among multiple	 max(ch(1),ch(2),ch(3))
	 specified values

min(<value>,...,<value>)	 Minimum value among multiple	 min(ch(1),ch(2),ch(3))
	 specified values

pp(<value>,...,<value>)	 (Maximum – minimum) among multiple	 pp(ch(1),ch(2),ch(3))
	 specified values

sum(<value>,...,<value>)	 Sum of multiple specified values	 sum(ch(1),ch(2),ch(3))
ave(<value>,...,<value>)	 Average of multiple specified values	 ave(ch(1),ch(2),ch(3))
poly(<x>,<a0>,<a1>,...,<an>)	 Polynomial with variable parameters	 poly(ch(1),ch(2),ch(3))	
	 Calculates a0xn+a1xn–1+...+anx0
ceil(<value>)	 Returns the minimum integer greater	 ceil(ch(1))
	 than <value>	

floor(<value>)	 Returns the maximum integer less	 floor(ch(1))
	 than <value>

limit(<x>,<a>,)	 If x is outside the range defined by a and b,	 limit(ch(1),10,20)
	 round the value to a or b.

rnd()	 Returns a random number between 0 and 1	ch(1)*rnd()
IsNaN(<value>) 	 Returns 1 if \value is NaN or 0 if it is not.	 IsNaN(ch(1))
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Time Functions
The table below shows the functions related to time. The functions are not case sensitive. 
Only integer numeric constants can be written in the function parameters <year>, 
<month>, <day>, <hours>, and <minutes> in the table below. The terminology used in 
the description in the table are defined below.
Edge:	 Returns 1.0 for computation immediately after the specified absolute or 

relative time.
Previous edge:	 Returns 1.0 for computation immediately before the specified absolute or 

relative time.
Level:	 Returns 1.0 during the specified absolute time or relative time.

•	 Selectable range of parameters
<years>:	 1970 to 2036
<month>:	 1 to 12 (1: January, 2: February, ..., 12: December)
<day>:	 1 to 31
<week day>:	0 to 6 (0: Sunday, 1: Monday, ..., 6: Saturday)
<hours>:	 0 to 23
<minutes>:	 0 to 59

Function	 Description	 Example
time(<year>,<month>,<day> <hours>,<minutes>)	 Edge operation on the date/time	 time(2003,6,3,9,53) ? StartRec() : 0
bfTime(<year>,<month>,<day>,<hours>,<minutes>)	 Previous edge operation	 bfTime(2003,6,3,9,3) ? 
	 on the date/time	 StartRec() : 0

time(<year A>,<month A>,<day A>,<hours A>,	 Level operation between	 time(2003,6,3,8,53,2003,6,3,9,13) ?
<minutes A>,<year B>,<month B>,<day B>,	 date/time A and B	 sum(ch(1),ch(2),ch(3)) : 0
<hours B>,<minutes B>)		

monthly(<day>,<hours>,<minutes>)	 Edge operation every month on	 monthly(3,9,53) ? StartRec() : 0
	 the specified day, hour, and minute.

bfMonthly(<day>,<hours>,<minutes>)	 Previous edge operation every	 bfMonthly(3,9,53) ? StartRec() : 0
	 month on the specified day,
	 hour, and minute.

monthly(<day A>,<hours A>,<minutes A>,	 Level operation between the	 monthly(3,9,3,4,9,3) ? StartRec() : 0
<day B>,<hours B>,<minutes B>)	 specified day, hour, and minute of
	 A to the specified day, hour, and
	 minute of B every month

weekly(<week day>,<hours>,<minutes>)	 Edge operation every week on the	 weekly(3,9,53) ? StartRec() : 0
	 specified week day, hour, and minute.

bfweekly(<week day>,<hours>,<minutes>)	 Previous edge operation every	 bfWeekly(3,9,53) ? StartRec() : 0
	 week on the specified week day,
	 hour, and minute.

weekly(<week day A>,<hours A>,<minutes A>,	 Level operation between the	 weekly(10,00,11,05) ? 
<week day B>,<hours B>,<minutes B>)	 specified week day, hour, and	 sum(ch(1),ch(2),ch(3)) : 0
	 minute of A to the specified week
	 day, hour, and minute of B every week.

daily(<hours>,<minutes>)	 Edge operation at the specified hour	 daily(10,00) ? StartRec() : 0
	 and minute every day

bfdaily(<hours>,<minutes>)	 Previous edge operation at the	 dfDaily(10,00) ? StartRec() : 0
	 specified hour and minute every day

daily(<hours A>,<minutes A>,<hours B>,<minutes B>)	 Level operation between time	 daily(10,00,11,05) ? sum(ch(1),
	 A and B	 ch(2),ch(3)) : 0

hourly(<minutes>)	 Edge operation at the specified	 hourly(30) ? StartRec() : 0
	 minute every hour

bfhourly(<minutes>)	 Previous edge operation at the	 bfHourly(30) ? StartRec() : 0
	 specified minute every hour

hourly(<minutes A>,<minutes B>)	 Level operation between	 hourly(10,20) ? 
	 minute A and B every hour	 sum(ch(1),ch(2),ch(3)) : 0

timer(<timerNo>)	 Returns the status of the specified	 timer(1)==1.0 ? StartRec() : 0
	 timer
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•	 Timer (<timerNo>)
	 Up to eight timers can be specified. The timer is specified using a number between 1 

and 8.
	 Select the timer operation from the choices below. Select Off to disable the timer.
	 Edge:	 Returns 1.0 when performing computation after the ON time elapses after the 

beginning of each interval. Specify the interval for detecting the condition and 
the ON time in ms.

	 Level:	 Returns 1.0 from the time after the ON time elapses until after the OFF time 
elapses. Specify the interval for detecting the condition, ON time, and OFF 
time.

	 The selectable range of the interval for detecting the condition is 1 s to 86400000 s = 
1000 days. The ON/OFF time is specified using the elapsed time from the beginning 
of the interval.

	 Timer Level Operation

			 

• When ON < OFF

• When ON > OFF

ON setting
OFF setting

t

Interval
Returns 1.0 Returns 1.0

Interval

ON OFF ON OFF

ON setting
OFF setting

t

Interval

Returns 1.0Returns 1.0 Returns 1.0

Interval

OFF ON OFF ON
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Event Functions
A function used to carry out a given operation (event). They are not case-sensitive. They 
are mainly used in conjunction with the conditional operator (?). The return values are 
indicated below. The event is actually executed after the computation is complete.
•	 Execution successful:	 1.0
•	 Execution failure:	 0.0
•	 Invalid parameter:	 NaN
Function	 Description	 Example
AlarmAck()	 Issue an alarm acknowledge	 ch(1)>ch(2) ? AlarmAck() : 0
ResetMath()	 Reset the computation	 ch(00010)>=1.0 ? ResetMath() : 0
ResetTimer()	 Reset the values of all timers	 ch(00010)>=1.0 ? ResetTimer() : 0
ResetTimer(<timerNo>)	 Reset the specified timer	 ch(00010)>=1.0 ? ResetTimer(1) : 0
ResetTLog()	 Reset the TLOG computation	 ch(00010)>=1.0 ? ResetTLog() : 0
StartRec()	 Start recording	 ch(00010)>=1.0 ? StartRec() : 0	
	 Valid after carrying out the
	 record start procedure.
	 Discarded if the recording is
	 already stopped (returns 1.0).

SplitRec()	 Move to the next record file	 ch(00010)>=1.0 ? SplitRec() : 0	
	 Valid after carrying out the
	 record start procedure.

StopRec()	 Stop recording	 ch (00010) >=0 ? StopRec() : 0	
	 Valid after carrying out the
	 record start procedure.
	 Discarded if the recording is
	 already started (returns 1.0).

Mark("mark")	 Create a mark. The text inside	 ch (00010) >=0 ? Mark("mark") : 0
	 the double quotation marks is
	 arbitrary.

•	 If the spacing between the execution of StopRec() and StartRec() is short, StartRec() 
may not be executed. When repeating start/stop frequently, consider using the Split 
function.

•	 The computed result at the time record start is executed is not necessary recorded to 
the file.
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Notes on Computation
•	 The equation is not case sensitive. The exception is tag numbers specified on the 

Channel setup screen.
•	 The precision and range of computed values are the same as data in single-precision 

floating point format.
•	 The sampling interval of the computed channel is 100 ms to 10 min.
•	 Measured value used in computations
	 The measured value with the closest time is used among the measured values 

existing at the time of computation. Resampling of the measured value or interpolation 
are not performed while computation is being executed.
Example 1:

	 If the measured values indicated by  and  exist and computation indicated by 
 is performed, the measured value indicated by  on each channel is used. If the 

measured value does not exist such as in Ch 5, NaN is used as the measured value.

	

Ch 1 :  : Data at time t
Ch 2 :  : Data near time t
Ch 3 :  : NaN
Ch 4 :  : Oldest data
Ch 5 :          : NaN
Computation : t Measured value used in

the computation of 

Example 2:
	 If the disconnection (disconnected after ) is detected, NaN is used as the measured 

value of Ch 3.

	

Ch 1 :  : Data at time t
Ch 2 :  : Data near time t
Ch 3 :  : NaN
Ch 4 :  : Oldest data
Ch 5 :          : NaN
Computation : t

Measured value used in
the computation of 

•	 Alarm values used in computations
	 Basically handled the same as measured values except the behavior differs in the 

following two cases.
•	 When the alarm value does not exist (Ch 5 in example 1 above)
	 Always returns 0 (no alarm).
•	 When the communication is cut off (Ch 3 in example 2 above)
	 Always returns the most-recent value.

•	 Syntax error and execution error
•	 Syntax error
	 Equations containing items that are inappropriate are indicated in peach when the 

equation is being entered. If monitoring is started without correcting the equation, 
they are ignored.

•	 Execution error
	 Execution errors are detected after starting the execution. Below are the two cases. 

NaN is returned as the result in either case.
•	 When the reference destination does not exist when monitoring is started
•	 When the computed result is undefined.

•	 Handling of NaN values
•	 In the case of a TLOG function (tlogmax, tlogmin, tlogpp, tlogsum, and tlogave)
	 If NaN exists in the channel values, it is handled as though the value did not exist.
•	 In the case of the IsNan() function
	 This function can determine whether the value is NaN.
•	 NaN is ignored for the functions min, max, sum, ave, and pp.
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•	 The value of NaN is considered true for the &&, ||, ^^, and ! operators.
•	 For all other computations
	 Computation is performed taking NaN as a value. Thus, NaN is returned as the 

computed result.
	 • The numeric value display on the Monitor screen displays INVALID.
•	 Handling when the value of a measurement channel is ±Over (exceeding the upper 

and lower limits of the measurement range)
	 If the measured value used in the reference function or TLOG function is ±Over, 

computation continues in one of two ways. Select the handling method using the 
Calculate +Over/–Over as the MAX/MIN value of a range check box.
•	 Continue the computation as ±Over.
•	 Continue the calculation by setting ±Over to the maximum or minimum value of the 

measurement range of the specified channel.
Use the following values as the maximum and minimum value of the measurement 
range.
•	 DC voltage: 	 ±10% of the range
	 Example:	 6 V range
		  +OVER: +6.6 V
		  –OVER: –6.6 V
•	 Temperature: 	±10ºC of the rated measurement range
	 However, 0 K and 10 K for KpVsAu7Fe and J263B.
•	 Linear scaling: Maximum and minimum values of the scale corresponding to ±10% 

of the measurement span
	 However, ±32000 when the scale value exceeds ±32000.
	 Example 1:	 When the measurement span is set to ±1 V and the scale is set to 
		  ±10000 at 2 V range
			   +OVER: 	 +22000
			   –OVER: 	 –22000
	 Example 2:	 When the measurement span is set to ±2 V and the scale is set to 
		  ±30000 at 2 V range 
			   +OVER: 	 +32000
			   –OVER: 	 –32000

	 To suppress ±Over from occurring in an arbitrary computation, use the limit function (see 
“Arithmetic Functions” under “Explanation” in this section).

•	 Alarms for computation using the Alarm() function
	 The alarm corresponding to the current value is used for the alarm of a measurement 

channel.
	 The alarm corresponding to the current value is used for the alarm of a computation 

channel. However, for computation channels that have not yet computed the current 
value, the alarm corresponding to the previous value is used.

Setting the Computation Span
This section provides an explanation of the span of transmission output for the analog 
output and PWM output modules.
•	 MATH channel range over
	 The upper and lower limits for the display of the monitor screen and other items. The 

MATH span setting range is as shown below depending on the decimal place. If the 
computed results fall outside of the MATH span setting range, they are displayed on 
screen as plus over or minus over data.
Decimal Place MATH span setting range Decimal Place MATH span setting range
0 –9999999 to 99999999 3 –9999.999 to 99999.999
1 –999999.9 to 9999999.9 4 –999.9999 to 9999.9999
2 –99999.99 to 999999.99
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2.6	 Displaying the Monitor and Setting the Display 
Procedure

Procedure

Changing the Display Settings on the Display Setup Screen

Channel display color
Trip point

Display zone position
Maximum/Minimum value of the scale

Select the display format of the Y-axis 
(normal/exponent)

Select the Y-axis type (linear/logarithmic)

Turn scale ON/OFF when displaying 
multi-axes zone

Channel select button
Display ON/OFF

Switch the display group
Group name

Execute automatic channel assignment
Number of channels assigned automatically

Restore the default maximum and minimum 
values of the entire scale

Turn ON/OFF the trip point display

Click here

1.	 Click Display to show the Display setup screen.

2.	 Change the display settings according to the explanation is the figure below.
Set the display for each display group. You can set up to ten display groups.

Initializing, Copying, and Pasting of Settings on the Display Setup Screen 
On the Display Setup Screen, you can reset the settings to default or copy and pate the 
settings of one or multiple waveforms to the settings of other waveforms. You can copy 
and paste according to the procedure below.
Click the copy source waveform number (No. column), choose Copy from the Edit menu, 
click the copy destination waveform number, and choose Paste from the Edit menu.

		

All ON or OFF

Select to copy
Do not copyRestore the default setting

Assign channels automatically
Copy first item to rest of selection

Select all channels
Drag to select the range
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Displaying the Monitor Screen and Settings on the Monitor Screen
1.	 Click Monitor to show the Monitor screen.

2.	 Change the display settings according to the explanation is the figure below.
If the channels of different interval groups or channels of computation groups are assigned 
to the same display group, a monitor is displayed for each interval group or computation 
group (see the figure below).

Switch the display group

Add a mark 
(cannot be used when paused)

Turn ON/OFF the waveform display
Change the background darkness
Change the grid density

Turn ON/OFF the waveform 
display limit (clip)

Switch the thickness of the 
displayed waveform

Switch the display zone
Zoom in or out of the time axis

Channel number and 
measurement unit

Y-axis scale
Switch the Y-axis channel

Click here
Switch to waveform, numeric, or 
waveform and numeric display

Note
You can switch the screen to waveform display, numerical display, or waveform and numerical 
display.

Setting the Status Bar Display on the View Menu
1.	 Click View to open the View menu.

2.	 Select the item to be shown or hidden.
Items that have check marks are shown.

					   

Communication statusDisk space Current time
Description of the status bar

Create file

Communication status
 : Connected
 : Disconnected
Monitor/Record status
 : Monitoring
 : Recording
 : Data dropout occurred
Write status
 : Writing
 : Write error

Number of data files created

Displays the remaining time until the next 
file is created using a bar (Move the cursor 
here to display the remaining time as a value)

Displays the remaining disk space 
using a bar (Move the cursor here to 
display the remaining space as a
percentage)

Displays the data rate using 
a bar (Move the cursor here
to display the data rate in 
bytes/second)

Note
If there is a record file that has not been finalized (data writing has not been completed) in 
the previous connection, the finalization of the record file is carried out immediately upon 
establishing the connection. If this occurs, the progress of the finalization is displayed on 
the status bar. The number of remaining data files is indicated between the Communication 
performance and Write status. If there are none, the bar is not displayed.

2.6  Displaying the Monitor and Setting the Display Procedure



2-45IM MX180-01E

Integration M
onitor

3

2

1

4

5

App

Index

Explanation
Display Groups and Group Names
On the Monitor screen, the channels are divided into groups and displayed using 
waveforms or numerical values. The measured/computed values can be divided into 
up to ten groups. Up to thirty-two channels can be registered to a single group. The 
channels that can be registered are those where the Monitor check boxes are selected 
in the Channel setup screen. When you click a channel selection button on the Display 
setup screen, the channel numbers of the channels that can be registered are displayed 
(see the figure below).

		

To turn ON/OFF the waveform display on the Monitor screen, click the light-blue button 
below the scale bar as shown in the figure below.

		

Hide the waveform

You can enter a group name using up to thirty characters. By default, group names 
Group 01 to Group 10 are assigned. The names of the display groups that have channels 
registered are displayed on the Monitor screen.

		

Y-Axis Type
You can select linear or logarithmic scale for the Y-axis when displaying the waveforms. 

		

Linear scale Logarithmic scale
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Maximum and Minimum Values of the Y-Axis and the Display Format of the 
Scale Values
Specify the maximum and minimum values of the Y-axis scale. The scale values can also 
be displayed using logarithmic format as shown below.

		

Select the exponential format

Selecting the Display Zone of the Waveform
You can select from the following. In the Zone setting on the Display setup screen, 
assume the bottom and top edges of the waveform display area to be 0% and 100%, 
respectively, and set the waveform display position by specifying the minimum value (0 
to 99%) and the maximum value (1 to 100%).
•	 User zone
	 Displays each waveform at the position specified by Zone on the Display setup 

screen. A single Y-axis scale of the active waveform can be displayed.

	

Select user zone

Click the bar to select the active Y-axis scale

Displays the active Y-axis scale

Indicates the active Y-axis

Set the display zone

•	 Edit zone
	 Like the user zone, each waveform is displayed at the position specified by Zone on 

the Display setup screen. However, you can change the zone on the Monitor screen. 
A single Y-axis scale of the active waveform can be displayed.

			 

Select edit zone

Drag the knob to change the minimum/maximum
value of the zone separately

Drag the bar to change the zone position without
changing the zone width

•	 Full zone
	 Displays all the waveforms over the full zone of the waveform display area regardless 

of the Zone settings on the Display setup screen. A single Y-axis scale of the active 
waveform can be displayed.

			 

Select full zone

Waveform display area
(Full zone)
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•	 Slide zone
	 Displays the waveforms by slightly offsetting the display position of each waveform 

vertically regardless of the Zone settings on the Display setup screen. A single Y-axis 
scale of the active waveform can be displayed.

			 

Select slide zone

Slide in this manner

•	 Auto zone
	 Displays the waveforms by dividing the waveform display area evenly according to the 

number of displayed waveforms regardless of the Zone settings on the Display setup 
screen.

			 

Select auto zone

Divide evenly automatically

•	 Multi-axis zone
	 All the Y-axes of the displayed waveforms are aligned horizontally. To hide a Y-axis 

scale, clear the Y-Axis check box on the Display setup screen. The display zone is set 
to the position specified by Zone on the Display setup screen.

Turn OFF the
Y-axis of
Ch00002

The scale of Ch00002
is not displayed

Select multi-axes zone

Click the bar to move the active
Y-axis to the left end

Indicates the active Y-axis
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Trip Point
You can display a trip line to indicate a particular value of interest (trip point) in the 
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each 
waveform. The trip line of the waveform corresponding to the left-most Y-axis is shown in 
the waveform display area.

		
Turn ON the trip 
line display

Trip 1 value

Trip 2 value Trip lineTrip 1 value Trip 2 value

Channel Color
Clicking the channel color displayed in the Color column on the Display setup screen 
opens the Color dialog box. You can select the color of each channel using the Color 
dialog box. To create custom colors, click the Define Custom Colors button in the Color 
dialog box.

		

Clipping of Waveforms
By default (clip OFF), the waveform is not displayed when the measured/computed value 
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip 
is turned ON, values that are smaller than the minimum value of the scale are displayed 
as the minimum value and the values that are larger than the maximum value of the 
scale are displayed as the maximum value.

		

Clip OFF Clip ON

Expanding or Reducing the Time Axis on the Waveform Display
On the waveform display, you can click the expand/reduce icon to expand or reduce 
the time axis for each waveform display area. The maximum magnification is x20. The 
minimum magnification varies depending on the size of the waveform display area.

		

Magnification

Time axis expand/reduce icon
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Adding Marks
You can display marks in the waveform display area (see the figure below). You can 
enter a text to be attached to the mark (“Mark” by default) using up to fifteen characters. 
Click the Mark button or choose Mark Configuration from the Action menu. You can enter 
the text in the dialog box that opens.
Up to 200 marks can be displayed. When 200 is exceeded, the marks are erased from 
the oldest ones. However, if the data is being recorded, the marks are saved to the 
record file.

		

MarkMark setup dialog box Text of the specified mark

Enter the text to be
displayed as a mark

If this check box is selected, the mark is placed without
displaying the dialog box when you choose Put a Mark
from the Action menu.

Note
Marks cannot be placed when the monitor update is paused.

Numeric Display
You can switch from the waveform display to numeric display as shown below.

		

Switch the display group

Switch to waveform, numeric, or 
waveform and numeric display

Channel display color

Channel number

Level indication with respect to 
the scale width

Numeric display

Unit

Waveform and Numeric Display

		

Switch the display group

Numeric display screen Waveform display screen

Change the display area
When paused, you can drag to change the 
display area of the digital and waveform 
displays.

Switch to waveform, numeric, or 
waveform and numeric display

2.6  Displaying the Monitor and Setting the Display Procedure



2-50 IM MX180-01E

2.7	 Starting and Stopping the Recording of 
Measured/Computed Data

Procedure

Record Start Operation
Click the Record button on the Monitor screen, or choose Record from the Acquisition 
menu.

		

Click

or

Choose

When recording starts, the display changes as shown in the figure below. To divide the 
file during recording, click the Manual Save button or choose Manual Save from the 
Acquisition menu.

		

When dividing files

Changes to red when recording starts

Changes to red when recording starts

Elapsed time of recording

or

Choose

While the Start Condition specified on the Acquisition setup screen is not met, the word 
“Waiting”appears under the Record button (see figure below).

		

Note
Clicking the Record or Stop buttons repetitively at short intervals or clicking the Manual Save 
button many times may hinder the measurement operation and file division process.

Record Stop Operation
To stop recording when Stop Condition specified on the Acquisition screen is set to 
Manual or before the stop condition is met, click the Stop button on the Monitor screen or 
choose Stop from the Acquisition menu.

		

Click

or

Choose
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When you click the Stop button on the Monitor screen or choose Stop from the 
Acquisition menu, a dialog box shown below opens.

		

Click OK. When you click OK, the word “Saving”appears below the Stop button until the 
recording stops.

Explanation
Start/Stop Recording
Data is recorded according to the Start condition and Stop condition specified on the 
Acquisition setup screen. Recording starts immediately when you click the Record button 
only when Start condition is set to On Record. For all other settings, the detection of 
whether the start condition is met is started when you click the Record button.

Note
•	 The creation of the data file starts after the recording is stopped. Therefore, it may take time 

for the data save operation to complete.
• 	 You cannot exit the software if the saving of the data is not complete. If you attempt to do 

so, a dialog box with the message “Writing data files Currently” opens. At the same time, the 
number of remaining record files to be finalized is indicated on the status bar (see section 
2.6, “Setting the Status Bar Display on the View Menu.”). The software closes when this 
indication clears.

• 	 If the record file cannot be created at the specified destination, the file is created in the Data 
folder in the directory where the MX100 Standard Software is installed.

•	 You can click the arrow button shown in the figure below to reduce the size of the display 
of the Record button and other items and widen the waveform display area. To set the size 
back to the original condition, click the arrow button again.

					   
Arrow button

2.7  Starting and Stopping the Recording of Measured/Computed Data
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2.8	 Pausing the Updating of the Monitor Display 
and Reading Measured/Computed Values 
Using Cursors

Procedure

Pausing and Resuming the Updating of the Monitor Display
To pause the monitor display, click the Pause button on the Monitor screen or choose 
Pause from the Acquisition menu. When paused, the word “Pause”under the button 
toggles between red and black.
To resume the monitor display, click the Pause button on the Monitor screen or choose 
Pause release from the Acquisition menu.

Click

or

Choose

Note
Recording continues even when the updating of the monitor display is stopped.

Reading Measured/Computed Values Using Cursors
When updating of the monitor display is paused, you can read measured (computed) 
values with the cursor. Click the position in the waveform display area where you wish to 
read the value. If you wish to read another point simultaneously, drag the mouse. Cursor 
A appears at the position where you first clicked; cursor B appears at the position where 
you released the mouse button. The measured point is the yellow circle displayed where 
the waveform and the cursor cross.

Change the display area

Time at Cursor B
Time at Cursor A

Scroll bar
Scroll button
Measurement point
Cursor B
Cursor A
Cursor movement button

Time between Cursors A and B

(value B) − (value A)
Readout value of Cursor B
Readout value of Cursor A
Channel number
Waveform display color
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To clear the cursors, choose Hide Cursor from the View menu. 

		  Choose

Explanation
Pausing the Updating of the Waveform Display
While monitoring the waveform, you can pause the updating of the waveform display and 
check the past waveforms (up to 1800 points).
Pausing the display on the numeric display holds the current values immediately before 
the pause operation on display.

Reading Measured/Computed Values Using Cursors
When the updating of the waveform display is paused, you can read values using 
cursors. Two cursors can be displayed. Below are the values that can be read using 
cursors.
•	 Values at the cursors.
•	 Difference in the value between the cursors.
•	 The time at the cursor position.
•	 The time between the cursors.

2.8  Pausing the Updating of the Monitor Display and Reading Measured/Computed Values Using Cursors
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2.9	 Setting Alarms and Alarm Indications

Procedure

Setting the Alarm

	

Rate-of-change interval 
when the Type is set to 
rHigh and rLow

Scroll to the right to 
display alarms 1 to 4

Hysteresis of alarm 2
Alarm value of alarm 2
Alarm 2 type
Hysteresis of alarm 1
Alarm value of alarm 1
Alarm 1 type

For computation 
channels Click here

1.	 Click Channel to show the Channel setup screen.

2.	 Click the Meas. Channel tab or the Math Channel tab.

3.	 In the Type list, select the alarm type for Alarm 1, Alarm 2, Alarm 3, or Alarm 4.
When not using difference input on measurement channels, select OFF, High, or Low. When 
using difference input, select OFF, dHigh, or dLow.
On computation channels, select OFF, High, Low, rHigh, or rLow.

4.	 Click the value box, and enter the alarm value.

5.	 Click the Hysteresis box, and enter the alarm hysteresis value.

6.	 If you selected a rate-of-change alarm rHigh or rLow for the alarm type, select the 
interval used to detect the rate-of-change from the Interval of rate-ofchange alarm 
list box.

Showing/Hiding Alarms
1.	 Click Monitor to show the Monitor screen.

2.	 Click the Alarm ON/OFF button.

					   

Show/Hide alarm

Alarm display area

Switch the active channel
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Explanation
Alarm Types
Alarm level settings and operation differ depending on the hardware style number of the 
MX100. See the table below.
Connectable module types or setting items MX100 Hardware Style Number*

S3 S2 S1
Alarm level setting (alarm 3 to alarm 4) Yes No No
Yes: Setting and operation allowed, No: Setting and operation not allowed
*  The style number is printed on the MX100 main module name plate.

There are six types of alarms.
When not using difference input on measurement channels, select OFF, High, or Low. 
When using difference input, select OFF, dHigh, or dLow.
On computation channels, select OFF, High, Low, rHigh, or rLow.

•	 Upper limit alarm (High)
	 An alarm occurs when the measured/computed value exceeds the alarm value.
•	 Lower limit alarm (Low)
	 An alarm occurs when the measured/computed value falls below the alarm value.
•	 Difference upper limit alarm (dHigh)
	 An alarm occurs when the difference input (difference between the measured value of 

its own channel and that of the reference channel) exceeds the alarm value.
•	 Difference lower limit alarm (dLow)
	 An alarm occurs when the difference input (difference between the measured value of 

its own channel and that of the reference channel) falls below the alarm value.

			 

Alarm value

Alarm reset
Measured value
or computed value

Alarm occurrence

Upper-limit alarm
Difference upper limit alarm

Lower-limit alarm
Difference lower limit alarm

Measured value
or computed value

Alarm reset

Alarm value
Alarm occurrence

•	 Upper limit on rate-of-change alarm (rHigh)
	 An alarm occurs if the amount of change in the computed value in the rising direction 

exceeds the alarm setting value within the rate-of-change detection interval.
•	 Lower limit on rate-of-change alarm (rLow)
	 An alarm occurs if the amount of change in the computed value in the falling direction 

exceeds the alarm setting value within the rate-of-change detection interval.

C
om

pu
te

d 
va

lu
e

Change in the
computed value

T1

Time

Interval

T2

t1 t2

T2

Time

T1

t1 t2

Change in the
computed value

Interval
t2–t1

Amount of change
in the setting |T2–T1|

Upper limit on rate-of-change alarm Lower limit on rate-of-change alarm

C
om

pu
te

d 
va

lu
e

t2–t1

Amount of change
in the setting |T1–T2|

The rate-of-change detection interval is equal to measurement interval × measurement 
count. Select the measurement count (1 to 15) using the Interval of rate-of-change alarm 
box.

2.9  Setting Alarms and Alarm Indications
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Alarm Hysteresis
You can set a width (hysteresis) to the values used to activate and release alarms. 
Alarm hysteresis prevents frequent activation and release of alarms when the measured/
computed value is unstable around the alarm value.

		

Alarm value

Alarm reset

Alarm occurrence

Upper limit alarm Lower limit alarm
Measured value
or computed value

Alarm reset

Hysteresis

Alarm value
Alarm occurrence

Measured value
or computed value

Alarm Indication on the Numerical Display
Four alarm signals are displayed above the value (see the figure below). The changes in 
the color of these alarm signals indicate the alarm status.

		

Alarm 1 status
Alarm 2 status

Alarm 3 status
Alarm 4 status

Black: Alarm not set

Green: Alarm OFF
Red: Alarm occurrence

Note
When using computation channel alarms, do not disconnect the MX100 and the PC software. 
Computation channel alarms will not occur because the computation function does not work 
when using only the MX100.

2.9  Setting Alarms and Alarm Indications
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2.10	 Digital Output Settings

Procedure

Setting the Digital Output of Alarms
Alarm reference channel

Select output or not output

Turn ON/OFF Alarm 1

Select the alarm Turn ON/OFF Alarm 4
Turn ON/OFF Alarm 3

Turn ON/OFF Alarm 2
Select hold/non-hold 
of output relay

Select energize/de-energize 
of output relay

1.	 Click Channel to show the Channel setup screen.

2.	 Click the DO Channel tab.

3.	 Select the Use check boxes for the DO channels you wish to output.

4.	 Click the Alarm button under Action.

5.	 Click the First or Last alarm reference channel box under Ref. Ch. and enter the 
measurement or computation channel numbers to reference for the alarm output.

6.	 Click the Level 1, Level 2, Level 3, or Level 4 button under Ref. Ch.

7.	 Click the Energize box to select an output relay action of Energize or De-energize.

8.	 Click the Hold box to select an output relay behavior of Hold or Non-hold.

Setting the Digital Output Other Than Alarms

Select output or not output If Action is set to Manual, 
click the button from 1 to 4Select the source action

Select hold/non-hold 
of output relay

Select energize/de-energize 
of output relay

4.	 Click the option button under Action to select the action used as the digital output 
source.

5.	 If you set Action to Manual, click any of the Manual DO buttons 1 to 4.

6.	 Click the Energize box to select an output relay action of Energize or De-energize.

7.	 Click the Hold box to select an output relay behavior of Hold or Non-hold.
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Explanation
Alarm Reference Channel Range
The alarm detection of multiple measurement channels or computation channels can 
be assigned to a single DO channel. If an alarm is detected on any one of the assigned 
channels, an alarm is output. A range of individual or consecutive channel numbers can 
be assigned.

Note
If connection with the PC is dropped, the state at the point at which the DO output was dropped 
is retained. However, DO output to which measurement channel alarm detection is assigned 
functions normally even if the connection with the PC is dropped.

Digital Output Operation Other Than Alarm Output
The digital output can be enabled for the following causes.
•	 Manual DO
	 DO channels assigned to the button number output relay contact signals collectively 

when the manual DO button on the Monitor screen is clicked.

			 

Manual DO button
Click to switch ON/OFF

•	 FAIL output
	 Outputs a relay contact signal when an error occurs in the main module CPU.
	 Relay output is turned ON (the relay is energized) when the CPU is operating 

normally. It is turned OFF when there is an error in the CPU and during power failures.
•	 Error output
	 Outputs a relay contact signal when any of the following events occur.

•	 A data output request timeout (60 s) occurs while recording data. (except when the 
/DS option functions are enabled)

•	 A module error occurs.
•	 An input module detected at power-on that is able to make measurements is 

removed.
•	 A module breaks down.
•	 An unidentifiable module is attached.

When using the energize setting for contact output, the circuit switches from open 
to short when the output is enabled. When using the de-energize setting, the circuit 
switches from short to open.

2.10  Digital Output Settings
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Energized/De-energized Operation of Output Relays
You can select whether the output relay is energized or de-energized when an output 
event (such as an alarm) occurs. If De-energized is selected, the output relay behaves 
in the same fashion as when an output event occurs if the power is cut off. The default 
setting is Energized.

	

NOEnergize

De-energize

C NO C NO C

NO C NO CNO C

When power is shut down

NO: Normally Opened, C: Common

When alarm is not occurring When alarm is occurring

Hold/Non-Hold of Output Relays
Select the behavior of the output relay when an output event is released (recovers to a 
normal condition). The default setting is Non-hold.
•	 Turn OFF the output relay with the release of the output event (non-hold).
•	 Hold the output relay at ON until the Relay ACK button (see below) is clicked.

		

Relay ACK button

Output cause
occurrence

• When set to non-hold • When set to hold

Relay output ON

Relay output OFF

Relay ACK

Relay output ON

Relay output OFF

Output cause
occurrence

2.10  Digital Output Settings
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2.11	 Analog/PWM Output Settings

Procedure

Analog Output Settings

	

Transmission output 
reference channel

Sets the output value upon 
startup or error occurrence

Output range 
selection

Minimum/Maximum value 
of output span

Select the source actionSelect output 
or no output

Selection of output 
action upon errors

Click here

Select the output 
action upon startup

1.	 Click Channel to show the Channel setup screen.

2.	 Click the AO Channel tab.

3.	 Select the Use check boxes for the AO channels you wish to output.

4.	 Specify a channel operation of Transmission output or User output. If user output 
is specified, you can enter settings in the monitor screen.
Only one of all the AO and PWM channels can be selected for user output.

5.	 When transmission output is specified, enter the Reference channel.
The reference channel cannot be entered if the channel operation is user output.

6.	 Select a range from the Range list box.

7.	 Click the Min box or Max box under Span and enter the minimum or the maximum 
value of the span.

8.	 Click the Power ON box under Output Action and select Hold previous value or 
Preset value.

9.	 Click the Error box under Output Action and select Hold previous value or Preset 
value.

10.	If you select Preset value under Output Action, click Preset value, and enter the 
voltage or current. 
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PWM Output Settings
	

Selection of output 
action upon errors

Transmission output 
reference channel

Sets the output value upon 
startup or error occurrence

Selection of output 
value upon startup

Selection of output action upon errors
Minimum/Maximum value 
of output span

Select output or no output

Enter the pulse interval coefficient

Select the resolution 
of the pulse output

1.	 Click Channel to show the Channel setup screen.

2.	 Click the PWM Channel tab.

3.	 Select the Use check boxes for the PWM channels you wish to output.

4.	 Specify a channel action of Transmission output or User output. If user output is 
specified, you can enter settings in the monitor screen.
Only one of all the AO and PWM channels can be selected for user output.

5.	 When transmission output is specified, enter the Reference channel.
The reference channel cannot be entered if the channel operation is user output.

6.	 Click the Min box or Max box under Span and enter the minimum or the maximum 
value of the span.

7.	 Click the Power ON box under Output Action and select Hold previous value or 
Preset value.

8.	 Click the Error box under Output Action and select Hold previous value or Preset 
value.

9.	 If you select Preset value under Output Action, click Preset value, and enter the 
duty.

10.	Select 1 msec or 10 msec in the Resolution list box under Pulse.
Click the Interval (msec) box under Pulse, and enter the pulse interval coefficient.

2.11  Analog/PWM Output Settings
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Turning Transmission Output ON and OFF Collectively for Analog Output/PWM 
Output

1.	 From the Action menu, choose Transmission output.
Transmission output on all active channels on the AO and PWM channel tabs is started (All 
ON).

2.	 From the Action menu, choose Transmission output again.
Transmission output on all active channels on the AO and PWM channel tabs is held at the 
values that were in use immediately before this operation was carried out.

Explanation
Setting up Output for AO Channels
Transmission Output:	 Values measured on the MX100, or computed values 

corresponding to computed results set on computation channels 
are converted to analog voltages (–10.000 V to 10.000 V) or 
analog current (0.000 mA to 22.000 mA) and output.

Note
The output range is –11.000 to 11.000 V or 0.000 to 22.000 mA, but the span setting range is 
–10.000 to 10.000 V or 0.000 to 20.000 mA.

User Output:	 You can set the analog voltage or analog current to an arbitrary 
value in the monitor screen. The setting ranges are –10.000 to 
10.000 V (voltage), or 0.000 to 20.000 mA (current).

Setting the User Output of the Voltage Value

Setting the User Output of the Current Value

Click to switch the display

Drag the pointer to set Click the input box, and enter a value

Setting up Output for PWM Channels
Transmission Output:	 Outputs a duty pulse waveform corresponding to values 

measured on the MX100, or the computed results set on the 
computation channels.

User Output:	 You can set the pulse duty ratio (0.000 to 100.000%) to an 
arbitrary value in the monitor screen.

	

Pulse interval

Output width

Duty ratio = x 100 [%]
output width
pulse intrvl

2.11  Analog/PWM Output Settings
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Setting the User Output of the Pulse (PWM Channel)

Click to switch the display

Drag the pointer to set Click the input box, and enter a value

Overview of Output Action When Setting Holding of Previous Value of 
User Output

Measurement start Measurement stop Measurement restartsPower ON

Output value
Value held

Note
If connection with the PC is dropped, the state at the point at which the AO or PWM output was 
dropped is retained. However, AO or PWM output to which measurement channel transmission 
output is assigned functions normally even if the connection with the PC is dropped.

2.11  Analog/PWM Output Settings
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2.12	 Saving/Loading and Printing Setup Data 
(Project)

Procedure

Saving Setup Data (Project)
1.	 From the File menu, choose Save or Save As.

2.	 If you select Save As, enter the file name in the Save As dialog box and then click 
the Save button.
If you attempt to save the file using an existing file name, a dialog box appears for you to 
confirm whether the file is to be overwritten.

					   

or

Loading Setup Data (Project)
1.	 From the File menu, choose Open.

2.	 In the Open dialog box, select a project file and click the Open button.

					   

Note
•	 When you carry out the procedure above, the current setup data is discarded and changed 

to the setup data of the project that is loaded. If you need the current settings, save the 
project before loading the setup data.

•	 If there is a strain module, you can also save or load the initial balance value. Using the 
project file, you can save or load multiple initial balance values.
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Printing Setup Data
1.	 From the File menu, choose Print.

The Print dialog box opens.

2.	 In the Print dialog box, select the printer, print range, and the number of copies, 
and then click OK.

					   

Display example of the Print dialog box

Print Preview
From the File menu, choose Print Preview.
The print image is displayed.

			 

Setting Up the Printer
1.	 From the File menu, choose Print Setup.

The Print Setup dialog box opens.

2.	 Set the paper size, orientation, and other settings. Then, click OK.

					   

Display example of the Print Setup dialog box

2.12  Saving/Loading and Printing Setup Data (Project)
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Explanation
Save Destination
The default save destination varies depending on the system that is running.

File Name
The extension is .mxp. The default file name is NewProject.mxp.

Creating a New Project
Create a new project when you wish to monitor the measured/computed data using new 
settings.

Printed Contents of the Setup Data
The following figure show how the setup data is printed.

	 	

2.12  Saving/Loading and Printing Setup Data (Project)
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2.13	 Other Displays and Settings

Procedure

Displaying the Version Information
1.	 From the Help menu, choose About.

A dialog box containing version information opens.
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3.1	 Loading Data Files

Procedure
1.	 Start the Viewer.

2.	 From the File menu, choose Open.

	 You can also click the  button on the toolbar.
The Open dialog box opens.

				  

File information
This information is also printed when the display data is printed

3.	 Select the file you wish to load and click Open.
The waveform display window opens.

When loading data files recorded using the MX100 Standard Software’s 
Integration Monitor
Before the waveform display screen appears, the message, “This file is not synchronized. 
OK to synchronize?” is displayed to confirm whether or not to perform the synchronization. 
To synchronize the data file, click Yes, otherwise, click No.

					   

Displays the waveform display window

The graphs for each monitor interval specified in the Acquisition Conditions screen 
of the Integration Monitor and the graph of computation channels are displayed
separately even within the same group.

Chapter 3	 Viewer
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Note
If you open a file (file created by recording the data of multiple units (MX100s)) created using 
MXLOGGER (software sold separately), a confirmation dialog box opens with a message “This 
file is not synchronized. Synchronize data file?” If you click No, a Select Unit No. dialog box 
opens. Click the desired unit number button to display the measured data of the corresponding 
unit and the computed data of MXLOGGER.

When Loading Data Files Divided on the MX100
If there are any files that can be joined a dialog box opens with the message, “Combining 
with related files?” before the waveform display window appears. Click the Yes button to join 
the files or the No button to display only the specified file.

				  

Displays the waveform display window

The graphs for each monitor interval specified in the Acquisition Conditions screen 
of the Integration Monitor are displayed separately even within the same group.

Explanation
Loadable Files
•	 Data files recorded using the Integration Monitor of the MX100 Standard Software or 

MXLOGGER (sold separately) (.mxd extension).
•	 Data files saved after performing synchronization using the Viewer (.mxs extension).
•	 Data backup files saved to the CF card using the MX100 (.MXD extension).

Display Range, File Size, and Number of Data Points of the Loadable Data
•	 50 groups
•	 Maximum channels per group: 32
•	 File size: 2 GB
•	 Data points: 5 million

Note
•	 When loading files with approximately 5 million data points, the error message “Insufficient 

memory. Please exit immediately.” may appear. If this happens, set the paging file size of 
the system virtual memory to 2 GB or more. To change the paging file size of the system 
virtual memory in Windows XP: In the control panel, double-click the System icon, click the 
Advanced tab, then click the Settings button under Performance. In the performance options 
dialog box, click the Advanced tab, then click the Change button under Virtual memory and 
make the desired changes.

•	 Whenever possible, avoid loading more than one file containing approximately 5 million data 
points because doing so can dramatically reduce the PC’s performance.

3.1  Loading Data Files
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Synchronization
The Integration Monitor of the MX100 Standard Software sends PC’s time information to 
the MX100 at measurement intervals. The PC’s time information is received along with 
the measured data when the data is received from the MX100. When measured data is 
recorded, the PC time information is also recorded.

	
PC Time

MX100

Packet

Packet
Measured data

Measured data

PC Time
.  .  . .  .  .

PC Time
MX100

PC

MX100

On the other hand, each MX100 makes measurements based on the main module 
clock. Therefore, the PC’s time that is recorded with the measured data and the PC’s 
time when measurements were made may be offset. When loading the data, the Viewer 
can process the time information to match the PC’s time that was present at time of 
measurement. This process is called synchronization (for details, see Note on the next 
page).
The measured data and computed data recorded using the Integration Monitor have 
time stamps attached by the MX100 main module (see section 1.2, “Main Module 
Functions” in the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E)). When 
synchronization is performed, the time stamps are changed using those of the PC as a 
reference. The file created by synchronization takes on the same file name with the .mxs 
extension.
When synchronizing, if the backup file is placed in the same folder, data dropout from 
the recording file is embedded from the backup file (data saved to the CF card), and 
synchronization of channel data is performed. Also, the between-channel delay in the 
medium speed modules is compensated during synchronization.
Synchronized files created by the synchronization process are created in the same 
directory as the data file normally displayed. The file name is “the name of the file being 
displayed (excluding the .mxd extension)” + “mxs extension” However, if the destination 
storage medium is write-protected, the file is created in the temporary file directory. The 
temporary file directory is displayed in an error message dialog box.
When divided files are loaded, they are joined by the synchronization process. If a 
file that can be joined to the displayed data exists and you synchronize the data, the 
existing synchronized file is overwritten. If the existing synchronized file cannot be 
overwritten (set to read-only attribute, for example), a new synchronized file is created. 
A sequence number is added to the name of the new synchronized file (“the name of the 
file being displayed”+ “sequence number”+ “mxs extension” For example, if the existing 
synchronized file name is “data-0000-1.mxs” the new file name is “data-0000-2.mxs”

3.1  Loading Data Files
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The following limitations exist in the joining of files through synchronization.
•	 If any of the divided files are missing, the files after (or before) the missing file are not 

joined.
•	 If the total number of measured data points in the divided files exceeds 5 million, only 

files that would not cause the total number of displayed data points to exceed 5 million 
are joined.

	 When synchronizing files that exceed the 5 million point range, a specified file is used 
as the start file and succeeding files are joined. If 5 million points is not exceeded 
when the last file is joined, files before the start file are searched for in order, and files 
that would not cause 5 million points to be exceeded are also joined. In this case, 
because the files before the start file are also joined to the previous synchronized file, 
two synchronized files for this file would exist. If you open a file before the start file and 
perform synchronization, the viewer displays the first file the OS finds (either of the 
two existing synchronized files). In such cases, it is recommended that the files you 
wish to join are selected so that the limit is not exceeded, copied to the user’s working 
folder, and synchronized there.

•	 Divided files can be joined up to the point in which the size of the joined file reaches 2 
GB.

Note
•	 Details of Synchronization
	 Given M recorded data points of a given channel of a data file that has not been 

synchronized, synchronization (linear interpolation) is carried out as follows: 
1.	 From the record start/stop time and record interval, determine N, the number of data 

points that will result after synchronization of the relevant channel.
2.	 From the record start time and record interval, determine Stn (n=0, ... , N–1), the PC time 

after synchronization of each data point.
3.	 From the record start/stop time and the PC millisecond clock counter values at record 

start/stop, determine PCcntPerms, the clock counter value per millisecond.
4.	 From the PC millisecond clock counter values recorded with the data before 

synchronization and PCcntPerms, determine Rtm (m=0, ... , M–1), the PC time of the 
data before synchronization.

5.	 Determine m such that the expression Rtm–1 ≤ Stn < Rtm is satisfied and retrieve the 
data values before synchronization VRtm–1 and VRtm at the PC time of Rtm–1 and Rtm.

6.	 Determine the data values after synchronization from the expression VStn = (Stn – Rtm–1) 
× (VRtm – VRtm–1)/(Rtm – Rtm–1) + VRtm–1 where (n=0, ... , N–1 and m=0, ... , M–1).

7.	 Determine the data values after synchronization for N data points, and then write them to 
the synchronized file.

				  

Rtm–2

VRtm–2

VRtm–1

VStn

VRtm

VRtm+1

Rtm–1 Stn Rtm Rtm+1 PC time

Data value

•	 When loading a data file saved by the MX100 to the CF card, synchronization is not possible 
because the PC time information needed in the data synchronization is not present.

•	 With the /DS option, when loading a data file saved by the MX100 to the CF card, 
synchronization is not possible because the PC time information needed in the data 
synchronization is not present.

•	 Synchronization may take time depending on the number of data points in the divided files.
•	 It is recommended that synchronization be performed on a hard disk with adequate free 

space.

3.1  Loading Data Files
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•	 Even when synchronization is performed, the files before synchronization (.mxd extension) 
are not deleted.

•	 If you change the PC’s time while data is being monitored on the Integration Monitor of the 
MX100 Standard Software, the error in the clock counter value per millisecond of the PC 
used in the synchronization process will become large. If the error in this value is greater 
than or equal to 2% when synchronizing the data file created at the time PC’s time was 
changed, the clock counter value of 1 millisecond is considered to be 1 for the purpose of 
synchronization.

•	 If communication is disrupted temporarily due to power failure or network failure during the 
recording operation, the PC time of the data measured by the MX100 while communication 
is disrupted (see “Details of Synchronization” above) is recorded as the old PC time before 
communication was disrupted in the file created immediately after communication recovers. 
If you attempt to synchronize this file, a dialog box with the message “Some channels do 
not have enough information to synchronize.” appears. In this case, synchronization is 
performed with the premise that the MX100 measured the data using the logical (estimated) 
record interval.

Joining
You can join data saved in the MX100’s CF card.

	

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Group 1

File groups with 
files numbered 0

This becomes the unit of joining

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  •

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

exit

*Max number of files

time

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Group 2

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  •

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

exit

Recording start Recording stop

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Group 3

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  •

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

exit

•	 Files from multiple measurement groups having the same file number are joined into 
file groups.

•	 The number of files contained in a file group must equal the number of measurement 
groups specified (for example, if 3 measurement groups are set, each file group 
contains 3 files). If one or more files are missing, file grouping stops.

•	 The resulting files that are created are limited to five million points or 2 GB. If the 
limit is not exceeded from the file group of the specified file number to the file group 
of the record stop file number, the software searches for file groups of file numbers 
preceding the file group of the specified file number and joins as many of them as 
possible without exceeding the limit.

•	 The extension for joined files is .mxc.

Note
•	 Copy CF card data to the PC hard disk before processing it.
•	 Joining may take time depending on the number of data points in the divided files.
•	 Even when joining is performed, files prior to the joining (with extension .MXD) are not 

deleted.

3.1  Loading Data Files
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3.2	 Display Settings

Procedure

Changing the Display on the Waveform Display Window
Change the display settings according to the explanation is the figure below.

Switch the display group

ScaleTurn ON/OFF the channel

Change the grid density

Change the background
darkness

Channel number and measurement unit

Zoom in or out
of the time axis

Switch the 
display zoneSwitch the active waveform

Alarm display ON/OFF
Clip display ON/OFF

Zone display area ON/OFF

Move the cursor to the 
point where the alarm 
changed

Switch the grid display

Changing the Display Using the Toolbar
Change the display settings according to the explanation is the figure below.

	

Channel number display

Show the General Display Settings window

Tag number display
Tag comment display

Switching between Absolute and Relative time
Show the waveform display window

Alarm/Mark List
Show the numeric display window

Show the window for displaying cursor values

Adding marks
Move cursor A to the left mark

Move cursor A to the right mark
Move cursor B to the left mark

Move cursor B to the right mark

Show the window for displaying statistical 
computation over an area
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3.2  Display Settings

Changing the Display Using the Menu
Choose appropriate commands from the Edit, View, and Window menus to change the 
display.

Show the computation result display window
Show the window for displaying cursor values

Show the computation result display window

Add/delete a mark

Clear the Cursor
Switch between channel number, tag number, 
and tag comment
Switch between absolute and relative time*
Turn ON/OFF the toolbar
Turn ON/OFF the status bar

Arrange the display window
(select cascade or tile)
Arrange window icons
Show the waveform display window
Show the numeric display window

Switch the display window

* Displays also the Format item during numeric
 display

Select how to arrange the display area from auto, horizontal, and vertical

Change the data file display

Alarm/Mark detailed list display

Changing the Display Using the Display Setup Window
See the explanation in the figure below. Change the display settings and click OK. 
Set the display for each display group.

	

Select the Y-axis
display format

Switch to another display group

Select channels (displays the channel selection dialog box)

Display ON/OFF Group name

Select the Y-axis type (linear/logarithmic)

Turn Y-axis ON/OFF when displaying multi-axes zone

Maximum and minimum
values of the scale

Turn ON/OFF the trip point display

Trip point value

Channel display color

Display zone position
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Explanation
Display Groups and Group Names
The values of each channel that are loaded are divided into groups that were used during 
recording and displayed using waveforms or numeric values. The measured/computed 
values can be divided into up to fifty groups. Up to thirty-two channels can be registered 
to a single group. If you click the channel selection button on the General Display 
Settings window, the Channel No. dialog box opens (see the figure below). The labels 
used to identify the waveforms can be set to tag numbers or tag comments in addition 
to channel number on the View menu. The selected label type (channel number, tag 
number, or tag comment) is used in the Channel No. dialog box. Select <None>, if you 
are not assigning a channel.

	

To turn ON/OFF the waveform display on the waveform display window, click the button 
below the scale bar as shown in the figure below.

	

Hide the waveform

The name assigned to each group can be changed using up to thirty characters. 
The names of the display groups that have channels registered are displayed on the 
waveform display window or numeric display window.

	

Y-Axis Type
You can select linear or logarithmic Y-axis for displaying the waveforms.

	

Linear scale Logarithmic scale

3.2  Display Settings
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Maximum and Minimum Values of the Y-Axis and the Display Format of the 
Y-Axis Values
The maximum and minimum values of the scale on the waveform display can be 
changed. If you click the Scale Calc. button on the General Display Settings window, the 
maximum and minimum values of the Y-axes on the selected channels are calculated 
automatically according to the maximum and minimum values of the data.
The scale values can also be displayed using logarithmic format as shown below.

	

Select the exponential format

Selecting the Display Zone of the Waveform
You can select from the following. In the Zone setting on the General Display Settings 
window, assume the bottom and top edges of the waveform display area to be 0% and 
100%, respectively, and set the waveform display position by specifying the minimum 
value (0 to 99%) and the maximum value (1 to 100%).
•	 User zone
	 Displays each waveform at the position specified by Zone on the General Display 

Settings window. A single Y-axis active channel waveform can be displayed.

		

Select user zone

Click the bar to specify the active channel

Displays the Y-axis
of the active channel

Indicates the
bar for the active
channel

Set the display zone

•	 Edit zone
	 Like the user zone, each waveform is displayed at the position specified by Zone 

on the General Display Settings window. However, you can change the zone on 
the waveform display window. A single Y-axis scale of the active channel can be 
displayed.

		

Select edit zone

Drag the knob to change
the minimum/maximum
value of the zone separately

Drag the bar to change the zone position
without changing the zone width

3.2  Display Settings
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•	 Full zone
	 Displays all the waveforms over the full zone of the waveform display area regardless 

of the Zone settings on the General Display Settings window. A single Y-axis scale of 
the active channel can be displayed.

		

Select full zone

Waveform display area (full zone)

•	 Slide zone
	 Displays the waveforms by slightly offsetting the display position of each waveform 

vertically regardless of the Zone settings on the General Display Settings window. A 
single Y-axis scale of the active channel can be displayed.

		

Select slide zone

Slide in this manner

•	 Auto zone
	 Displays the waveforms by dividing the waveform display area evenly according to 

the number of displayed waveforms regardless of the Zone settings on the General 
Display Settings window.

		

Select auto zone

Divide evenly automatically

3.2  Display Settings
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•	 Multi-axes zone
	 All the specified Y-axis of the displayed waveforms are aligned horizontally. To hide 

a Y-axis, clear the Y-axes check box on the General Display Settings window. The 
display position is set using Zone on the General Display Settings window. Dragging 
the channel bar to the waveform display area shows the Y-axis of the corresponding 
channel. Dragging the Y-axis to the zone display area hides the Y-axis of the 
corresponding channel.

		
Turn OFF the Y-axis
display of Ch00002

The Y-axis of Ch00002 is not displayed.

Select multi-axes zone

Click the bar to move the specified Y-axis to the right end

Indicates the
specified Y-axis

Grid Display
Select the grid type.

When this is selected When this is selected When this is selected

Trip Point
You can display a trip line to indicate a particular value of interest (trip point) in the 
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each 
waveform using the Trip 1 and Trip 2 settings on the General Display Settings window. 
The trip line of the waveform corresponding to the right-most Y-axis bar is shown in the 
waveform display area.

	

Turn ON the trip line display

Trip 1 value*

Trip 2 value*

Trip line
Trip 1 value

Trip 2 value

* Can be moved
 by dragging

3.2  Display Settings
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Channel Color
Clicking the channel color displayed in the Color column on the Display setup screen 
opens the Color dialog box. You can select the color of each channel using the Color 
dialog box. To create custom colors, click the Define Custom Colors button in the Color 
dialog box.

	

Clipping of Waveforms
By default (clip OFF), the waveform is not displayed when the measured/computed value 
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip 
is turned ON, values that are smaller than the minimum value of the scale are displayed 
as the minimum value and the values that are larger than the maximum value of the 
scale are displayed as the maximum value.

	

Clip OFF Clip ON

Expanding or Reducing the Time Axis on the Waveform Display
On the waveform display window, you can click the zoom in/out icons to zoom in or out 
on the time axis in the range of 20 to 1/1000 times for each waveform display area.

	

Magnification

Time axis expand/reduce icon

3.2  Display Settings
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Adding Marks
In addition to the marks placed using other programs such as the Integration Monitor, 
you can add marks at the positions where you click (displays a cursor) on the waveform 
display area. You can enter a text to be attached to the mark (“Mark”by default) using up 
to fifteen characters. You can also select Left, Center (default), Right, or Flag (small mark 
without text) for the Type. For types other than Flag, the specified string and the relative 
or absolute time at the mark position are displayed.
You can set the string and type in the Mark dialog box that opens when you click the 
Append Mark icon (or choose Append Mark from the Edit menu). In the Mark dialog box, 
you can select whether to add the mark to the waveforms of all groups (default) or only 
the waveforms of the displayed group.
To delete specific displayed marks, select the range using cursors, and then choose 
Delete Mark from the Edit menu. To delete all the marks added using the Viewer, choose 
Reset Mark from the Edit menu.

Left endAdd mark icon CenterFlagDisplay the cursor

or
Marks added on the Viewer are green,
and marks added on other programs
are orange.

Double-click the mark to change the settings

Switching between Absolute and Relative Time 
By default, the time axis is displayed using absolute time. The time axis can also be 
displayed using time relative to the first data position.

	

Switch absolute/relative time

Absolute Time Relative time

On the numeric display, you can select the display format of the absolute or relative time 
and turn ON/OFF the data numbers using Format on the View menu.

	

In the alarm/mark list, the time is always displayed using absolute time.

3.2  Display Settings



3-14 IM MX180-01E

Showing/Hiding Alarms
You can hide the alarm display area that indicates the status of alarm occurrence. The 
alarms are displayed in the same fashion as the alarms displayed in the waveform 
display area of the Integration Monitor.

	

Show/Hide the alarms No alarm display

Alarm display area

Alarm/Mark List Display
Displays a detailed list of alarms and marks.
From the Window menu, choose Alarm/Mark List.
You can also click the  button on the toolbar.

•	 Alarm List

		

Currently sorted to the item indicated by this mark
Sorted according to the clicked item

•	 Mark List

  Mark added by 
Viewer software

Mark added in computation 
channels of the Integration 
software’s channel screen

Mark added in the 
Integration software’s 
Monitor screen

Names of groups with marks
If the groups have no names, all groups are marked

Currently sorted to the item indicated by this markSorted according to the clicked item

3.2  Display Settings
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The alarm/mark list display’s cursors are linked with those of the waveform display and 
numeric display layout screens. Alarms or marks selected with the cursor in the alarm/
mark list display can be copied to the clipboard using the Edit > Copy command.
The alarm/mark list can be converted to ASCII, Excel, or Lotus format (see section 3.7).

Alarm display limitation:	 One file can display a maximum of 10000 alarms.

Left-to-Right Alarm Search (Waveform Display Screen Only)

	

Move cursor B to the next alarm change point on the left
Move cursor B to the next alarm change point on the right

Move cursor A to the next alarm change point on the right
Move cursor A to the next alarm change point on the left

Cursor A
Select the active channel

Cursor B

Alarm display

Left-to-Right Mark Search (Waveform Display Screen Only)
In the waveform display screen, move cursor A and B to the right or left side of the mark.
From the Edit menu, choose Mark Search. Or click the corresponding toolbar button.

	

Move cursor B to the left mark
Move cursor B to the right mark

Move cursor A to the right mark
Move cursor A to the left mark

Mark
The marks added in the Integration 
software’s Monitor screen are orange, 
marks added in the computation 
channels are yellow, and those 
added in the Viewer software are green.

3.2  Display Settings
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Numeric Display
Numeric display can be shown along with the waveform display window. When a group 
contain channels with different measurement intervals, the screen is divided accordingly. 
The display group, active channel, and mark display are synchronized to the waveform 
display.
If cursors are displayed on the waveform display window, the data values between the 
cursors are displayed in red. Also, the data column corresponding to the cursor position 
is displayed in gray.

	

Date/Time

Switch the display 
group

Alarm

Channel display color

ValueData number

Active channel (Y-axis displayed 
on the waveform display)

Mark
indicationHorizontal scroll

Display per record interval

Note
•	 If you open the numeric display window when two cursors are shown on the waveform 

display window, the data in the interval between the cursors is displayed in red. If you 
choose Copy from the Edit menu (press the Ctrl + C key) in this condition, the data in the 
interval is copied to the clipboard as text data.

•	 Up to 1000 lines can be copied. (Copy on the Edit menu is not available if the number of 
lines specified by the cursors is above 1000.)

•	 If data of multiple measurement intervals is displayed, the data in the interval between the 
cursors on the data sheet with the active measurement interval is copied. (The newest line 
is displayed in light blue on the data sheet with the active measurement interval. The newest 
line and the newest column are displayed using the same color on non-active sheets. You 
can activate a sheet by clicking the sheet.)

3.2  Display Settings
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Initializing, Copying, and Pasting of Settings on the General Display 
Settings Window
On the General Display Settings window, you can reset the settings to default or copy 
and pate the settings of one or multiple waveforms to the settings of other waveforms. 
You can copy and paste according to the procedure below.
Drag the copy source waveform numbers (No. column), click the Copy button, drag the 
copy destination waveform numbers, and click the Paste button.

	

Click this button to turn ON/OFF the channels collectively

To copy/paste the item,
click to show the flag.

To not copy/paste the item,
click to hide the flag

Click this button
to reset to
default settings

Click this button to automatically assign the channels
in order

Click this button to enter the same settings
as the first channel in the selected range

Click to select all the channels
Drag to select a range

To paste the copied settings

To copy
the settings

To set the scale to match
the maximum and minimum
values of the data

Applying Data File Display Conditions
Group display conditions set using Viewer (including group data display conditions 
reflecting the use of templates or the display conditions setting file) are cleared, and the 
channel display returns to the data file display settings.
The settings configured using the tool buttons in the upper part of the waveform display 
screen for each group (alarm display ON/OFF, time axis zoom in/out, display zone 
switching, grid display switching, and grid display ON/OFF), and the grid color and 
waveform background color settings are restored to their default settings.

	

Zoom in or out of the time axis
Switch the display zone

Alarm display ON/OFF

Clip display ON/OFF
Switch the grid display 

Move the cursor to the point where the alarm changed

3.2  Display Settings
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3.3	 Reading Values Using Cursors

Procedure
1.	 On the waveform display window, click the tag of the group from which you wish 

to read the value using cursors.

2.	 Click the position of the desired data in the waveform display area of the 
waveform display window.
If you wish to read another point simultaneously, drag the cursor. Cursor A appears at the 
position where you first clicked; Cursor B appears at the position where you released the 
mouse button. A yellow circle is displayed where the waveform and the cursor cross.
You can move the waveform that is displayed in the waveform display area using the scroll 
buttons or scroll bar.

				  

Cursor A
Cursor B Measurement point

Group selection tab

3.	 From the Window menu, choose Control.

				  

The Cursor Value window opens.

				  

Channel number and
measurement unit

Channel display color

Time between Cursors A and B

Time at Cursor B

Time at Cursor A

Readout value of Cursor B – Readout value of Cursor A
Readout value of Cursor B

Readout value of Cursor A

Alarm
indication

Data number at Cursor A

Move
Cursor A

Data number at Cursor B

Move
Cursor B

Difference in the data number
between Cursors A and B
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Clearing the Cursor
From the Edit menu, choose Erase Cursor.
The cursors are cleared as well as the cursor values displayed in the Cursor Value dialog 
box.

Explanation
Reading Measured/Computed Values Using Cursors
Two cursors can be displayed. The following values can be read on the Cursor Value 
window.
•	 Values at the cursors.
•	 Difference in the value between the cursors.
•	 Absolute time and data number at the cursor position.
•	 Time between the cursors and the difference between the data numbers.
•	 Alarm status of the value at the cursor.

Note
•	 The cursors used to display cursor values and those used to specify the interval for 

statistical computation over an area are the same.
•	 The Cursor Value window and the Statistics window can be displayed simultaneously.

•	 If you click the tab of another group on the waveform display window while the Cursor Value 
window is open, the cursor values of the selected group are displayed on the Cursor Value 
window.

•	 You can change the cursor positions on the waveform display window while the Cursor 
Value window is open.

•	 If you choose Select All from the Edit menu, Cursor A is displayed at the first data position 
and Cursor B is displayed at the last data position.

3.3  Reading Values Using Cursors
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3.4	 Statistical Computation over an Area of 
Measured/Computed Data

Procedure
1.	 On the waveform display window, click the tab of the group on which you wish to 

perform statistical computation over an area.

2.	 Click the start position of the computation area in the waveform display area.
A light-blue cursor appears in the waveform display area. If multiple waveform display areas 
are displayed, the cursor is displayed at the time position each waveform display area.

3.	 Drag the cursor to the end position of the computation area.
Another light-blue cursor appears at the position where the cursor was dragged.

				  

Group selection tab

Cursor (the start of the statistical computation over an area)
Cursor (the end of the statistical computation over an area)

4.	 From the Window menu, choose Statistics.

					   

The Statistics window opens.

				  

Channel number and 
measurement unit

Channel display color

Data number at the start position
of the statistical computation
over an area

Data number at the end position of the 
statistical computation over an area

Copy data to the clipboard

Minimum value

Maximum Value

Maximum value – Minimum value

Average value

RMS value
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Explanation
Statistical Computation over an Area
Specify using two cursors the interval over which computation is to be performed. 
If the cursors are not displayed, all the data are used in the statistical computation. 
The statistical parameters are the minimum value, the maximum value, the P-P value 
(maximum – minimum), the average value, and the rms value.

Copying Data to the Clipboard
If you click the Copy button, the results of statistical computation over an area are copied 
to the clipboard as text data. You can press Ctrl + C when the statistical computation 
over and area window is active to copy the displayed results as text data to the clipboard. 

Note
•	 To redo the computation after changing the computation area, you must select the “statistics 

calculated over an area display window” button (see “Procedure” in section 3.2) or the menu 
command again.

•	 The cursors used to specify the interval for statistical computation over an area and those 
used to read values are the same.

•	 The Statistics window and the Cursor Value window can be displayed simultaneously.

3.4  Statistical Computation over an Area of Measured/Computed Data
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3.5	 Saving the Display Settings

Procedure
1.	 From the File menu, choose Save Display Setting File.

You can also click the  button on the toolbar.
The display setting file is created in the same folder as the data files.

				  

When Closing the Viewer
If you open a file and change the display settings, the dialog box below opens when you 
attempt to close the Viewer. To save the changed display settings, click Yes.

	

Explanation
Display Settings That Are Saved
•	 Information about the group whose waveform or numeric display is open.
•	 Settings entered using the tool buttons at the top section of the waveform display area 

of each group.
	 Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
•	 Cursor position (absolute time).
•	 General Display Settings on the View menu.
•	 Channel No., Tag ID, and Tag comment settings on the View menu.
•	 Absolute Time or Relative Time setting on the View menu.
•	 Graph/Sheet Layout setting on the Window menu.
•	 Check box items in the File Information dialog box on the Information menu.
	 The items are used as headers when the data is printed.
•	 Print setting on the File menu.
	 Range, Color, Print Groups, and Comment.
•	 Marks created on the Viewer.
•	 Position of the display screen.

Display Setting File
The display setting file (with the .mxv extension) is created in the folder containing the 
data files. If the data file name is data.mxs, the display setting file name is data.mxs.mxv. 
The next time the data file is opened, the display opens according to the information in 
the display setting file.
If the display setting file is deleted or moved to another folder, the display opens 
according to the display settings used when the data file was created.

Note
You cannot open a file containing the data you wish to view by selecting a file with .mxv 
extension.
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3.6	 Saving the Display Template

Procedure
Saving Templates

1.	 From the File menu, choose Save Template.
The currently displayed settings are saved as a template file to the same folder as the 
displayed data.

				  

Using Templates
1.	 From the File menu, choose Use Template.

If the currently displayed data is not in the display conditions file, it is displayed according to 
the setting information of the template file residing in the same folder.
If the currently displayed data is in the display conditions file, it is displayed according to the 
setting information of the display conditions file.

Explanation
The template file is saved with the name default.mxt in the folder of the currently 
displayed data.
When using a template file, the template file residing in the same folder as the displayed 
data is used.
The setting information saved to the template file is as follows.
•	 Information about the group whose waveform or numeric display is open.
•	 Settings entered using the tool buttons at the top section of the waveform display area 

of each group.
	 Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
•	 General Display Settings on the View menu.
•	 Channel No., Tag ID, and Tag comment settings on the View menu.
•	 Absolute Time or Relative Time setting on the View menu.
•	 Graph/Sheet Layout setting on the Window menu.
•	 Check box items in the File Information dialog box on the Information menu.
	 The items are used as headers when the data is printed.
•	 Print setting on the File menu.

Range, Color, Print Groups, and Comment.
•	 Position of the display screen.
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3.7	 Converting Data Formats

Procedure
1.	 From the Convert menu, choose To ASCII, To Excel, or To Lotus.

				  

2.	 After entering various settings in the dialog box that opens, click OK. The file is 
created at the specified destination.
Waveform, Numeric, or Waveform/Numeric Display

Enter the range of group numbers to be converted

Select whether to set the range
to be converted using groups
or channels

Select the range of channels to be
converted
Click to open the selection dialog box.Select the record interval

Only the channels with the selected
record interval are converted.

Enter the data range to be
converted
Can be specified using cursors
before opening this dialog box.

Displays the time of the specified data

When changing the save destination or file name
Click to open the save destination and file name
setup dialog box.

Step when saving data at certain intervals

Displays the save destination
and file name

Alarm/Mark List Display

				  
When changing the save destination or file name
Click to open the save destination and file name setup 
dialog box.

Displays the save destination and file name

Explanation
Data Formats for Conversion
•	 ASCII

Text data with each data point separated by a comma. The extension is .txt.
•	 Excel
	 Data that can be opened using Microsoft’s spreadsheet application Excel version 8.0 

(Excel 97) or later. The extension is .xls.
•	 Lotus
	 Data that can be read using IBM’s Lotus 1-2-3 spreadsheet program version 2.0 or 

later. The extension is .wj2.
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Converted Data 
Specify the range using group numbers or channel numbers. You can select the channel 
number by clicking in the dialog box as shown below.

	

If multiple record intervals exist in the data to be converted, select the recording interval. 
Only the data of the channels having the selected recording interval is converted.

Conversion Range and Step
You can specify the range using data numbers or by using cursors. For information on 
specifying the range by using cursors, see “Procedure” in section 3.4. By specifying the 
step, you can save data sampled at certain intervals rather than converting all the data in 
the range (when step is set to 1).

Display Example of the Converted Data

	

Notes When Converting Data
•	 There is a limit in the number of data points that Excel and Lotus 1-2-3 can handle. 

Before conversion, set the data to be converted, the conversion range, and steps such 
that the number of data points is appropriate. In addition, if there is little free memory 
in the PC, Excel or Lotus 1-2-3 may not be able to load the data. 

•	 If conversion conditions are specified that exceed the limitations of Excel or Lotus 
1-2-3, the data is automatically divided before conversion. Therefore, multiple files are 
created. The file names are assigned automatically with sequential numbering. (For 
example, when converting the file “data.mxs” to Excel format, if the data is divided 
into n number of files, they are named data.mxs.0000.xls, data.mxs.0001.xls, ..., data.
mxs.000n.xls).

•	 Up to 65510 data and 252 channels are saved to a single conversion file (when 
columns are channels and rows are data).

•	 If you set the save destination to a storage medium that has slow access such as a 
floppy disk, the saving of the data may take an extended time. It is recommended that 
such storage medium not be selected for the save destination.

•	 Select a save destination with adequate free space.
•	 The measured data during a burnout or measured data that exceeds the upper/lower 

limit of the measurement range are indicated as “OVER”or “OVER”
•	 If invalid data exists in the converted data (measured value of a channel without input 

or computed value when the data used in the equation does not exist), the data is 
indicated as “INVALID”

3.7  Converting Data Formats
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3.8	 Printing the Data

Procedure

Setting the Contents to Be Printed
1.	 From the File menu, choose Print Settings.

				  

2.	 In the Print Setting dialog box, set Range, Color, and Print Group, and then click 
OK.
Enter a comment in the Comment box as necessary.
When printing numeric values, only a print range need be selected.

				  
Enter the comment to be printed

Switch to settings for numeric values

Select the groups when Selected
Groups is selected
Click to open the group selection
dialog box

Select monochrome or color print

Select the group to be printed

Settings for numeric values

Select to print all or print only the range specified by cursors



3-27IM MX180-01E

View
er

3

2

1

4

5

App

Index

Executing the Print Operation
1.	 From the File menu, choose Print.

The Print dialog box opens.

2.	 In the Print dialog box, select the printer, print range, and the number of copies, 
and then click OK.
When printing waveforms, you cannot set the print range.

				  

Display example of the Print dialog box

Print Preview
1.	 From the File menu, choose Print Preview.

The print image is displayed.

				  

Setting Up the Printer
1.	 From the File menu, choose Print Setup.

The Print Setup dialog box opens.

2.	 Set the paper size, orientation, and other settings. Then, click OK.

					   

Display example of the Print Setup dialog box

3.8  Printing the Data
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Explanation
Printed Items
To print waveforms, open the waveform display window; to print numeric values, open 
the numeric display window; to print alarm or mark lists, open the alarm/mark list display 
window. If multiple waveform display windows or numeric display windows are open, click 
the window you wish to print.
Also, to print alarm/mark lists, cursor values, or statistics calculated over and area along 
with waveforms, display those windows as well.
Print Range
If you wish to print only a specified range of the waveform, specify the range using 
cursors. For information on specifying the range by using cursors, see “Procedure” in 
section 3.4.
Printed Colors of Waveforms
You can select to print in black and white or in color.
Print Groups
•	 On Display Only
	 Only the groups whose waveforms are displayed are printed.
•	 All Groups
	 All groups that can be displayed on the waveform display window are printed.
•	 Selected Groups
	 Groups selected in the dialog box that opens (see the figure below) when the Select 

button is clicked are printed.

		

Printing a Comment
You can enter a comment using up to 127 characters. The comment is printed in the Print 
Comment column.
Printing File Information
When you print data, the file information is also printed. You can check the file information 
in the dialog box that appears when choosing File Information from the Information 
menu. You can also select the items to be printed using the check boxes.

	

3.8  Printing the Data
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Print Example
•	 When only the waveforms are printed

		

File information

•	 When cursor values, values of statistical computation over an area, and waveforms 
are printed

File information

Statistical
computation
over an area

Cursor values

3.8  Printing the Data
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•	 When printing an alarm list

		

•	 When printing a mark list

		

•	 When printing a list of numeric values

		

3.8  Printing the Data
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4.1	 Connecting the MX100

Notes before Using the Calibrator
•	 If the MX100 is connected using the Integration Monitor, drop the connection before 

connecting the MX100 using the Calibrator.
•	 If you change the module configuration before connecting with the Calibrator, use the 

Integration Monitor to reconfigure the system (see section 2.2).

Procedure
1.	 Start the Calibrator.

The Unit Information window opens.

2.	 In the IP Address/Host Name box, enter the IP address or host name of the 
MX100 to be calibrated.

3.	 Click Connect.

					   

Enter the IP address or host name of the
MX100 to be calibrated.

Execute connection

Chapter 4	 Calibrator
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	 When the connection is established, information about the unit’s module 
configuration is displayed.

					   

To disconnect the connected MX100
To illuminate the 7-segment LED of the 
connected MX100 to see which MX100 is 
connectedInformation about the connected MX100

Modules attached to the 
connected MX100

	 If the specified IP address or host name is not correct, or the MX100 is connected 
by another software program, the following dialog box opens.

					   

Note
•	 You cannot change the MX100 network settings using the Calibrator. Use the Integration 

Monitor (MX100 Standard Software) to change the IP address and other settings.
•	 If you change the module configuration before connecting with the Calibrator or if modules 

that are not operating properly exist, X marks are displayed on the modules as shown 
below.If you change the module configuration, use the Integration Monitor to reconfigure the 
system.

					   

•	 When using Windows XP, Windows Vista, or Windows 7 with the firewall enabled, 
recognition is sometimes not successful even when clicking the Search button. To solve the 
problem, see appendix 1. (The same problem may also occur if your anti-virus software is 
using a firewall.)

4.1  Connecting the MX100
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Setting a Password for Startup
You can use the following procedure to set up the Calibrator so that it prompts the user 
to enter a password upon startup.

1. 	 From the File menu, click Set Password.
The password setting dialog box opens.

					   

2.	 Click the New Password box, and enter a password.
There are no restrictions on the characters that can be used in the password. However, the 
number of characters used must be no more than thirty.

3.	 Enter the same password in the Confirm New Password box, then click OK.
When the Calibrator is restarted, the password confirmation dialog box below appears. 
If an incorrect password is entered and the OK button is clicked, the message, “Incorrect 
Password” is displayed in a dialog box. Click OK to exit the Calibrator.

					   

Note
To set up the Calibrator so that no password dialog box is displayed, open the password setting 
dialog box, make sure the entry boxes are blank, and click OK There is no other way to cancel 
the password, so make sure you do not forget the password once it is set.

Explanation
Checking the Connected MX100
When the connection is established, the Unit Information window shows the serial 
number, MAC address, and input/output modules of the connected MX100. If you click 
the Check button, the 7-segment LED on the main module of the connected MX100 
shows the text “--CALL--” flowing from right to left.

4.1  Connecting the MX100
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4.2	 Calibration Procedure

Notes on Calibration
•	 Do not perform other operations during calibration. Take extra care because if you 

perform another operation while calibration is in progress, the module may suffer a 
break down.

•	 When connecting the plate with screw terminals (model 772080) to the 10-CH, 
Medium-Speed Universal Input module, note that the terminal arrangement is different 
than when connecting clamped terminals.

	 With the calibration software, modules to which plates with screw terminals are 
connected are recognized as clamp terminals, meaning that the wiring diagrams show 
the wiring for the clamp terminals.

	 Therefore when wiring and calibrating, refer to the text describing the terminal function 
and terminal symbols that show the type of signals input to each terminal that are 
printed on the back of the terminal cover of the 10-CH, plate with screw terminals.

			 

CH1 
1 
2 

CH2 
3 
4 

CH3 
5 
6 

CH4 
7 
8 

CH5 

11  RTD 11  RTD 

9 
10 

CH6 
1 
2 

CH7 
3 
4 

CH8 
5 
6 

CH9 
7 
8 

CH10 
9 
10 

Note: The b terminals are common to all channels.
 They are connected internally.

Procedure
1.	 Click the illustration of the input/output module that you wish to calibrate.

					     Moving the pointer over 
an module that can be 
calibrated shows the word 
“Calibrate”
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2.	 On the calibration detail setup screen that appears, select the channel and range 
to be calibrated and click the >> button. 

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the channel and the
measurement range to be
calibrated from the list

	 The figure below is an example of the 10-CH, Medium-Speed Universal Input 
Module. Channels are not selected.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement
range to be calibrated
from the list

	 The figure below is an example of the 30-CH, Medium-Speed DCV/TC/DI Input 
Module. Channels are not selected.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement
range to be calibrated
from the list

4.2  Calibration Procedure
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	 The figure below is an example of the 6-CH, Medium-Speed, Four-Wire RTD 
Resistance Input Module. Channels are not selected.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement
range to be calibrated
from the list

	 The figure below is an example of the 4-CH, Medium-Speed Strain Input Module. 
Channels are not selected.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement
range to be calibrated
from the list

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output 
Module. A range is not selected.

					   

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement
range to be calibrated
from the list

4.2  Calibration Procedure
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3.	 After making the connections according to the explanation given on the calibration 
execution screen 1, click the Calibrate button.

	 For the 8-CH Medium Speed Analog Output module, after entering settings 
according to the explanation given on the calibration execution screen 1, click the 
Calibrate button.

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

	 Exp.	 Calibration execution screen 1

					   

Start calibration

Return to the previous screen
Return to the Unit Information screen

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output 
Module.

	 Exp.	 Calibration execution screen 1

					   

Start calibration

Return to the previous screen
Return to the Unit Information screen

	 Click the Calibrate button.
The message, “Calibrating. Please wait and do not perform any other operation.” appears.
When the calibration completes successfully, the calibration execution screen 2 appears.

4.2  Calibration Procedure
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	 If the calibration fails, a message “Failed to calibrate.”appears.

					   

Note
For a description of the accuracy of the connected input module, the calibration accuracy, 
and the environmental conditions for calibration, see the MX100 Data Acquisition Unit User’s 
Manual (IM MX100-01E).

4.2  Calibration Procedure
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4.	 After making the connections according to the explanation given on the calibration 
execution screen 2, click the Calibrate button.

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

	 Exp.	 Calibration execution screen 2

					   

Start calibration

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output 
Module.

	 Exp.	 Calibration execution screen 2

					   

Start calibration

	 Click the Calibrate button.
The message, “Calibrating. Please wait and do not perform any other operation.” appears.

5.	 Repeat steps 1 to 4 until all calibrations are completed.

6.	 From the File menu, choose Write.
The calibration values are written to the input module.

					   

Note
During calibration, do not perform any other operations (especially turning the MX100 OFF or 
dropping communications). Doing so may cause the MX100 main unit to stop working. 

4.2  Calibration Procedure
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4.2  Calibration Procedure

Explanation
Calibrated Parameters
•	 4-CH, High-Speed Universal Input Module (MX110-UNV-H04)
	 Calibration is carried out on a channel-by-channel basis.

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV 20 mV
60 mV 0 mV 60 mV
200 mV 0 mV 200 mV
1 V 0 V 1 V
2 V 0 V 2 V
6 V 0 V 6 V
20 V 0 V 20 V
100 V 0 V 100 V
RTD(1 mA)200 mV 0 Ω 200 Ω
RTD(1 mA)600 mV 0 Ω 300 Ω
RTD(1 mA)1 V 0 Ω 500 Ω
RTD(2 mA)60 mV 0 Ω 30 Ω
RTD(2 mA)200 mV 0 Ω 100 Ω
RTD(2 mA)600 mV 0 Ω 300 Ω
RTD(2 mA)1 V 0 Ω 250 Ω

•	 10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1 V 0 V on CH1 1 V on CH2
2 V 0 V on CH1 2 V on CH2
6 V 0 V on CH1 6 V on CH2
20 V 0 V on CH1 20 V on CH2
100 V 0 V on CH1 100 V on CH2
RTD(1 mA)60 mV 0 Ω on CH3 60 Ω on CH6
RTD(1 mA)200 mV 0 Ω on CH3 200 Ω on CH4
RTD(1 mA)600 mV 0 Ω on CH3 300 Ω on CH5

•	 30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1 V 0 V on CH1 1 V on CH2
2 V 0 V on CH1 2 V on CH2
6 V 0 V on CH1 6 V on CH2
20 V 0 V on CH1 20 V on CH2
100 V 0 V on CH1 100 V on CH2
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4.2  Calibration Procedure

•	 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-V4R-M06)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1 V 0 V on CH1 1 V on CH2
2 V 0 V on CH1 2 V on CH2
6 V 0 V on CH1 6 V on CH2
20 V 0 V on CH1 20 V on CH2
100 V 0 V on CH1 100 V on CH2
RTD(1 mA)20 mV 0 Ω on CH3 20 Ω on CH4
RTD(1 mA)60 mV 0 Ω on CH3 60 Ω on CH5
RTD(1 mA)200 mV 0 Ω on CH3 200 Ω on CH6
RTD(1 mA)600 mV 0 Ω on CH3 300 Ω on CH4
RTD(0.25 mA)600 mV 0 Ω on CH3 2400 Ω on CH5
RTD(0.25 mA)1 V 0 Ω on CH3 3000 Ω on CH6

•	 4-CH, Medium-Speed Strain Input Module (MX112-B12-M04, MX112-B35-M04, 
MX112-NDI-M04)
Measurement Range to 
Be Calibrated

Connection 1  
(Zero Calibration)

Connection 2  
(Full Calibration)

2000 µSTR (strain) 120.000 Ω on R1 to R4 of CH2 120.000 Ω on R1 to R3 of CH2 
and 117.154 Ω on R4

20000 µSTR (strain) 120.000 Ω on R1 to R4 of CH2 120.000 Ω on R1 to R3 of CH2 
and 113.010 Ω on R4

200000 µSTR (strain) 120.000 Ω on R1 to R4 of CH2 120.000 Ω on R1 to R3 of CH2 
and 80,000 Ω on R4

	 Use a 4-gauge method connection when performing calibration. For information on 
this connection, see section 2.4 of the MX100 Data Acquisition Unit User’s Manual (IM 
MX100-01E).

•	 8-CH, Medium-Speed Analog Output Module (MX120-VAO-M08)
	 Adjust so that all channels output 0 V and 10 V. This differs from other input modules.

Range to Be Calibrated Output Value 1 Output Value 2
10 V 0 V 10 V

Note
•	 For a description of the measurement range and accuracy of each input module, see 

chapter 4 in the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
•	 For a description of the calibration procedure and wiring, see section 3.3 of the MX100 Data 

Acquisition Unit User’s Manual (IM MX100-01E).
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5.1	 Troubleshooting

If servicing is necessary, or if the instrument is not operating correctly after performing 
the corrective actions below, contact your nearest YOKOGAWA dealer for repairs.

The 7-segment LED does not illuminate. 

Message Corrective Action Reference 
Page

The power switch is not ON. Turn ON the power switch. *
The supply voltage is too low. Check whether the voltage is within the supply voltage rating 

range.
*

The fuse is blown. Servicing required. -
The power supply is broken. Servicing required. -
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

The 7-segment LED blinks repeatedly. 

Probable Cause Corrective Action Reference 
Page

The power supply is shorted inside the input/
output module.

Remove the module one by one and determine which module 
is broken. (Servicing required.)

-

The power supply is shorted inside the main 
module.

Replace the main module. 
(Servicing required.)

*

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

After power up, the 7-segment LED displays something other than  (when the unit number is 00).

Probable Cause Corrective Action Reference 
Page

The display is b* (* is any character other than F).
The dipswitch settings are not correct.

Turn OFF the power, remove the CF card, turn ON all dip 
switches, and power up again.  If the situation does not 
change, servicing is required.

*

The display is bF. 
The dipswitch settings are not correct.

Powering up in setup reset mode. Turn OFF the power, turn 
ON all dip switches, and power up again.
Since all settings such as the IP address are initialized, 
reconfiguration is necessary.

2-7, *

The display is F* (where * is any character).
Hardware error on the main module.

Servicing required. -

The display is E* (where * is any character).
Hardware error on the input/output module.

The slot number is indicated by * in the n* display following the 
E* display.
Remove the relevant module and power up again. 
The relevant module must be serviced.

*

The display is P0. 
CF card operation error.

Do not manipulate the CF card while it is being accessed. *

The display is P1. 
CF card error.

Reformat the CF card or replace the CF card. 2-11, *

The display is P2. 
CF card format error.

Check whether the CF card is inserted correctly. Then, reformat 
the CF card or replace the card. 

2-11, *

The display is P3. 
CF card insufficient free space

Delete the files on the CF card to free up some space. -

The display is P4. 
CF card number of files over the limit.

The number of created files exceeded the allowed amount.
Stop the recording, replace the CF card or delete files and 
restart.

*

The display is P5. 
Overwrite error in the data storage buffer.

The time needed to store the file must be reduced.
Delete unneeded data to increase the free space, or format the 
CF card. 

*

The display is C1. 
Multiple TCP connections.

Turn OFF the power and reconnect. *

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

Chapter 5	 Troubleshooting
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The MX100 cannot be detected from the PC or cannot be detected with the Search button.

Message Corrective Action Reference 
Page

The LINK LED does not turn ON. 
The cable is broken.

Replace the Ethernet cable. *

The LINK LED does not turn ON. 
There is a problem with the hub.

Check the hub’s power supply. If it still does not work, replace 
the hub and check the hub’s operation. Also, try to connect the 
MX100 using the 10-Mbps fixed mode.

*

The LINK LED does not turn ON. 
There is a problem with the PC.

Check whether the PC can connect to the network. 
Replace the PC’s NIC.

*

The ACT LED does not turn ON. 
There is a problem in the connection between 
the hub and the MX100.

Check the hub’s power supply. If it still does not work, replace 
the hub and check the hub’s operation. 
Also, try to connect the MX100 using the 10-Mbps fixed mode.

*

The ACT LED does not turn ON. 
There is a problem with the PC.

Check whether the PC can connect to the network. 
Replace the PC’s NIC.

*

There is a problem in the network configuration. 
The settings are not correct.

Check that the IP address, subnet mask, and default gateway 
settings of the PC correspond to the MX100 settings.

2-7

There is a problem in the network configuration. 
The setting changes have not taken effect.

Turn OFF the power to the PC and the MX100, and carry out 
reconnection.

2-5, *

PC and the MX100 are not in the same segment.
 

Connect the PC and the MX100 in the same network segment.
If the PC and the MX100 are connected as shown in the 
following figure, the Search button cannot be used to detect 
the MX100. However, you can make a connection manually by 
specifying the IP address.

2-7

MX

PC

Router

Network A

Network B

When using Windows XP, Windows Vista, or Windows 7, check 
the firewall function.

2-1, App-1

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

The MX100 is detected by clicking the Search button, but connection cannot be made.

Message Corrective Action Reference 
Page

The IP address is set to the default value. 
The default value cannot be used to make the 
connection.

Enter the correct IP address. 2-7

There is a problem in the network configuration. Check that the IP address, subnet mask, and default gateway 
settings of the PC and the MX100 settings are correct.

2-7

The PC software, main module style number, 
and release number do not conform to the rule.

Check the release number of the PC software and the main 
module style number, then upgrade the style.  
[PC software release no.] ≥ [main module style no.]

**

** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).

MX100 cannot be connected using the Calibrator

Message Corrective Action Reference 
Page

Attempting to make multiple connections. 
Another software program is already connected.

Exit all other software programs. -

The main module and input/output module style 
numbers do not conform to the rule.

Check the release number of the PC software and the main 
module style number, then upgrade the style. 
[PC software release no.] ≥ [main module style no.] ≥  
[input/output module style no.]

**

** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).

5.1  Troubleshooting
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The connected input/output module is not detected.

Message Corrective Action Reference 
Page

Module connection or module startup error. 
Attached the module while the power was ON.

Turn OFF the power. Detach the input/output module once and 
attach it again.

*

The PC software, main module, and input/output 
module style and release numbers do not 
conform to the rule.

Check the release number of the PC software and the main 
module style number, then upgrade the style.  
[PC software release no.] ≥ [main module style no.] ≥  
[input/output module style no.]

**

Carried out an incorrect calibration. Recalibrate. 4-4
Connecting the 10-CH, Pulse Input Module 
(MX114-PLS-M10).

The 10-CH Pulse Input Module cannot be used with the 
MX100. Use this module with the MW100.

*

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).

Alarms are not output.

Message Corrective Action Reference 
Page

There is a problem in the alarm setting. Make the alarm and numerical output (relay) settings 
appropriate.
Both the alarm and numerical output (relay) must be set.

2-54 to 2-59

Current is not output from the analog output module, and no output comes from the PWM output module.

Message Corrective Action Reference 
Page

External power supply required. Connect an external power supply. *
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

Transmission output is not output from the analog output module, nor from the PWM output module.  

Message Corrective Action Reference 
Page

“Transmission output execution” not enabled. Enable it. 2-62

No output from the PWM output module

Message Corrective Action Reference 
Page

The output current limit (1 A) has been 
exceeded. Once the limit is exceeded the 
protection circuit activates and will not recover 
until you turn OFF the external power.

Turn OFF the power. Check the load, then turn ON the power 
again.

-

The fuse is blown. (4 A/module limit has been 
exceeded)

Servicing required. -

The CF card is not detected.

Message Corrective Action Reference 
Page

There is a problem with the CF card. Replace the CF card. 
Eject and format the CF card, then insert it again.

*

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

5.1  Troubleshooting
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The measured value is not correct.

Message Corrective Action/Description Reference 
Page

The input wiring is not correct. Check the input wiring. *
The measured value indicates +Over or –Over. 

The measurement range setting and input 
range do not match.

Change to an appropriate setting. *

The temperature error is large or is unstable. 
The TC type setting and the type actually 
connected are different.

Change to the correct setting. *

The temperature error is large or is unstable. 
The RJC setting is not correct.

Change to the correct setting. *

The temperature error is large or is unstable. 
The wind is hitting the terminals.

Block the wind from hitting the terminals. -

The temperature error is large or is unstable. 
The ambient temperature change is drastic.

Suppress changes in the ambient temperature such as by 
placing the MX100 in a box.

-

The temperature error is large or is unstable. 
There is an error in the wiring resistance (in 
the case of an RTD).

Match the thickness and length of the three input wires. *

The measurement error is large or is unstable. 
Noise effects.

Take measures against noise. *

The measurement error is large or is unstable. 
Effects from the signal source resistance.

Reduce the signal source resistance such as by inserting  a 
converter.

-

The temperature error is large or is unstable. 
Effects from parallel connections.

Stop parallel connections. 
Do not use the burnout setting.

-

Measured value from strain gauge type sensor 
not correct.

When using a sensor without a remote sensing wire, use the 
DV450-001 (conversion cable).

*

On the strain module (-B12, -B35), the gauge 
method dipswitch settings are not correct.

Enter the correct settings.  *

On the strain module (-B12, -B35), the gauge 
resistance  and internal bridge resistance values 
are different.

Use a module that supports the resistance value of the strain 
gauge (for 120 Ω, -B12, and for 350 Ω, -B35.)

*

On the strain module, scaling corresponding to 
the gauge method is not set  
(for 2 gauge, 4 gauge methods, the amount of 
strain is doubled or quadrupled).

Displayed with 1 gauge method conversion. 
Set scaling appropriately depending on the gauge method. 

*

On the strain module (-NDI), a strain gauge type 
sensor without a remote sensing wire is being 
used.

When using a sensor without a remote sensing wire, use the 
DV450-001 (conversion cable).

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

5.1  Troubleshooting
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5.2	 Error Messages and Their Corrective Actions

 Error Messages on the Integration Monitor

Error Code Message Corrective Action/Description Reference 
Page

IP address is invalid. Enter the correct IP address. 2-7
Subnet mask is invalid. Enter the correct subnet mask. 2-7
Default gateway is invalid. Enter the correct gateway address. 2-7
Failed to update. Attempted to change the IP address while the connection is 

established, or the MX100 you wish to configure is connected 
by another software program. Disconnect the MX100.

-

Search MX100s nearby again. Click the Search button again on the Connection screen, and 
change the settings.

2-1, 2-5

Broken modules exist. Remove the input/output modules one by one and determine 
the broken module, then replace it.

*

Some modules are not calibrated 
correctly.

Recalibrate. 4-4

Undetermined  directory. The save destination of the record file cannot be found. Check 
whether the save destination exists.

2-16

Write error The record file cannot be created. Check whether free space 
on the destination drive exists, whether write permissions have 
been granted, whether the disk is damaged, and whetherthe 
file system is corrupt.

-

E5102 Failed to format CompactFlash. Check whether communication with the MX100 is being 
performed. 
Insert a CF card correctly.

2-7 
 
*

E5103 Invalid serial number. Please 
reinstall the software.

Enter the correct serial number. 1-5

E5104 Failed to create folder. The directory of the folder to create is not correct. Check the 
file save destination.

2-16

E5105 Invalid folder name. Please enter 
a new name.

Entered folder name is incorrect. Enter a correct folder name. -

E5106 Cannot contain any of the 
following characters: 
\\ / : , ; * ? " < > | CON PRN AUX 
CLOCK$ NUL COM1-9 LPT1-9

Entered folder name includes illegal characters. Enter a correct 
folder name.

-

E5107 Compact Flash slot is empty. Insert a CF card correctly. *
W5131 Update the display settings. The display setup is initialized according to the measurement 

and computation channel settings.
2-43

W5132 Writing data files Currently. During finalization, do not close MX100 Standard. 2-51
W5133 Cancel the current settings and 

create a new project?
Settings are discarded and the MX100 Standard is restored to 
its default state.

2-6

W5134 The current channel setup 
contains invalid use of reference 
channels.

Click No and change the settings of the improper channels. To 
disable the channels with improper settings, click Yes.

2-25 to 2-27

W5135 In order to balance the strain 
channels, it's necessary for 
channels to be set up correctly. 
The current channel setup 
contains invalid use of reference 
channels.

Click No and change the settings of improper channels. To 
disable the channels with improper settings, click Yes.

2-25 to 2-27

W5136 Format Compact Flash? The CF card is formatted. 2-11
W5137 Stop Record? Data saving stops. 2-51
W5138 Module settings which do not 

match the current software 
configuration will be initialized.

If you click Yes, settings of modules that differ between the 
MX100 module configuration and the configuration recognized 
by MX100 Standard will be initialized. To not reconfigure, click 
No.

2-10

W5139 Some detected modules do 
not match the current software 
configuration. Rebuild based on 
the current MX hardware setup?

Click Yes reconfigure. To not reconfigure, click No. 2-9

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
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Error Code Message Corrective Action/Description Reference 
Page

E0004 File write error. The file cannot be created for some reason. -
E0212 Can’t read file. Target files cannot be loaded, or are deleted. 3-2
E3111 Channels of the specified 

recording interval do not exist.
Channels with the specified measurement interval do not exist 
in the conversion of the data format. 
Change to the correct setting.

3-24

E3114 Sampling data number is over 
the Viewer display limit of 5 M.

Attempting to load a file containing 5 million or more data 
points.

3-2

E3120 Not a data file. Target files cannot be loaded, or are damaged. 3-2
E3153 File open error. File not created because allowable number of files in the CF 

card will be exceeded. Delete files to reduce the total number.
3-5

W3115 Exceeded the range of the Excel 
sheet. Convert to Excel?

Change the range to be converted so that it is within the 
allowed range of Excel.

3-25

W3116 Exceeded the range of the  
Lotus 1-2-3 sheet. Convert to 
Lotus?

Change the range to be converted so that it is within the 
allowed range of Lotus 1-2-3

3-25

Error Messages on the Calibrator

Error Code Message Corrective Action/Description Reference 
Page

W4700 Connection failure. Check 
the IP Address/Host Name or 
Calibration mode.

To change the network settings such as the IP address, start 
the Integration Monitor. 
The MX100 has no Calibration mode.

2-5

W4701 Failed to write the calibrated 
value.

Recalibrate. If the message is still displayed, service required. 4-4 to 4-9

W4702 Failed to calibrate. Recalibrate. If the message is still displayed, service required. 4-4 to 4-9

5.2  Error Messages and Their Corrective Actions
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Appendix 1	 Configuring/Removing the Firewall

Check the following before attempting to configure or remove a firewall.
•	 Check the internet connection status using the ping command. If the ping fails, check 

the cables, hub, IP address settings, and other factors to determine the cause.
•	 Check that procedures performed on the software are correct.
If the problem cannot be solved after taking the above measures, it is likely that there will 
be problems with the firewall settings. Configure or remove the firewall according to the 
following procedure.
Note that the following procedure describes the MX100 Standard, but it applies to the 
MX100 Calibration Software as well.

Appendix
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Windows XP SP3
1.	 From the Start menu, click Control Panel.

The Control Panel opens.

					   

2.	 Double-click Windows firewall.
The Windows Firewall dialog box appears.

					   

3.	 If Off is selected, click Cancel to exit.

	 If On is selected, clear the Don’t allow exceptions check box.

					   

Appendix 1  Configuring/Removing the Firewall
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4.	 Click the Exceptions tab, then click the Add Program button.
The Add program dialog box is displayed.

					   

5.	 Select MX100 Standard, then click the OK button.

					   

6.	 Click the Exceptions tab. Confirm that the MX100 Standard item was added, 
then select the MX100 Standard check box and click the OK button.

					   

Appendix 1  Configuring/Removing the Firewall
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Windows Vista
1.	 From the Start menu, choose Control Panel.

The control panel opens.

					   

2.	 Click Allow a program through Windows Firewall.
The User Account Control dialog box appears.

					   

3.	 Click Continue.
The Windows Firewall Settings dialog box is displayed.

					   

Appendix 1  Configuring/Removing the Firewall
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4.	 Click the General tab.
If Off is selected, click Cancel to exit.
If On is selected, clear the Block all incoming connections check box.

					   

5.	 Click the Exceptions tab, then click the Add Program button.
The Add a Program dialog box is displayed.

					   

6.	 Select MX100 Standard, then click the OK button.

					   

Appendix 1  Configuring/Removing the Firewall
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7.	 Click the Exceptions tab. Confirm that the MX100 Standard item was added, 
then select the MX100 Standard check box and click the OK button.

					   

Appendix 1  Configuring/Removing the Firewall
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On Windows 7
1.	 Click the control panel on the Windows Start menu.

The Control Panel appears.

					   

2.	 Click System and Security.

					   

3.	 Click Windows Firewall.
The Windows Firewall Settings dialog box is displayed.

					   

Appendix 1  Configuring/Removing the Firewall
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4.	 Click Advanced settings.

					   

5.	 Click Windows Firewall Properties.

					   

6.	 Click the tab of the profile appropriate for your operating environment. When the 
Firewall state is Off, click Cancel to exit.
When the Firewall state is On, and Inbound connections or Outbound connections is 
Block, proceed to next step.

					   

Appendix 1  Configuring/Removing the Firewall
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7.	 Click Inbound Rules.

					   

8.	 Select the Program check box. Click Next.

					   

Appendix 1  Configuring/Removing the Firewall
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9.	 Select the This program path check box. Select MXStandardE.exe from the 
software’s installation folder and click Next.

					   

10.	Select the Allow the connection check box. Click Next.

					   

Appendix 1  Configuring/Removing the Firewall
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11.	 Specify the profiles for which this rule applies. Click Next.

					   

12.	Specify the name of this rule, and click Finish.

					   

13.	Follow the same procedure as the one in step 7 and select MXCalibE.exe and 
MxEngine.exe.

14.	For Outbound Rules as well, follow the same procedure as the one in step 7 and 
select MXStandardE.exe, MXCalibE.exe and MxEngine.exe.

Appendix 1  Configuring/Removing the Firewall
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